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1. Trademarks

1. TRADEMARKS

2. INTRODUCTION

The terms HDMI, HDMI High-Definition Multimedia Interface and the HDMI logo are trademarks or registered 
trademarks of HDMI Licensing LLC in the United States and other countries.

Thank you for choosing the Analog Way Eikos². Before you start setting up your Eikos² for the first time, 
please read through all of the documentation to become familiar with its powerful features. The Eikos² can 
be used in several configurations, which results in a versatile video production tool for live event staging and 
fixed installation applications.
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3. Terms and definitions

3. TERMS AND DEFINITIONS
BACKGROUND: a “Background” is a source, typically originating from a computer. Eikos² enables you to work 
with still (frame) background — visually in back of all other sources.

LAYER: a “layer” is an image display element (such as a PIP window, Key, logo or Background) that has a visual 
priority — either in front (or in back) of another layer. 1 frame non-resizable, up to 4 live layers resizable and 
2 logos available on the Eikos².

PIP: a “PIP” (Picture In Picture) is a picture, typically of reduced size, which is positioned over another 
background image or other PIPs. PIPs can be repositioned, reduced, enlarged and displayed with borders. 
PIPs can overlap, depending on their visual priority. Eikos² offers various slides, wipes, and fades for dynamic 
PIP entrances and exits. A “flying” PIP is also possible using vertical, horizontal, or diagonal movement. A PIP 
is considered as a layer.

FRAME: a “frame” is a full screen image which is selected from one of the still frames you can capture. A 
frame can be captured in flash memory from any video or computer source plugged into the machine.

LOGO: a “logo” is a part of a screen image that can be captured in flash memory from any video or computer 
source, by keying or image cut-out. A logo can be positioned anywhere on the screen.

KEYING: “Key” is an electronic process whereby a video image is electronically superimposed over another 
source or background, by dynamically removing a portion of the first image. For example, removing all content 
of a certain color (such as green or blue) is called a Chroma Key, and removing content based on its brightness 
or luminance levels is called a (Luma Key). Keys are typically used for titles, logos and special effects. Eikos² 
allows you to key a live source (such as a camera shot with green or blue background, or a title with a black 
background) over any other source or sources.

SEAMLESS: Clean transition with no glitch or loss of sync while switching between two sources. For example, 
fading through black to another source is a seamless transition.

TRUE SEAMLESS: Clean seamless transitions with no glitch or freeze between two sources. For example, 
crossfading from source to source is a true seamless transition. 

RCS²: Remote Control Software used to control, set up, and operate the device.

QUICK FRAME: The “Quick Frame” feature allows the instant display of a stored frame above all layers. 



9

4.1.1 English

4. HARDWARE SPECIFICATIONS

All of the safety and operating instructions should be read before the product is operated and should 
be maintained for further reference. Please follow all of the warnings on this product and its operating 
instructions.

•  WARNING: To prevent the risk of electric shock and fire, do not expose this device to rain, humidity or  
intense heat sources (such as heaters and direct sunlight). Slots and openings in the device are provided for 
ventilation and to avoid overheating. Make sure the device is never placed near a textile surface that could 
block the openings. Also keep away from excessive dust, vibrations and shocks.

•  POWER: Only use the power supply indicated on the device of the power source. Devices equipped with 
a grounding plug should only be used with a grounding type outlet. In no way should this grounding be 
modified, avoided or suppressed. Connection of equipment to main supply must be after branch circuit 
breaker of the building installation.

•  POWER CORD: The device is equipped with a detachable power cord, to remove mains disconnect it at 
appliance coupler. A rear switch is also available, turn OFF to switch off the device.

Caution:  The power cord constitutes the only mean to completely disconnect the equipment from the main 
power.

Apply the following guidelines:
-  The equipment connected to the network must have a release system easily accessible and located 

outside the unit.
- Unplug the power cord; do not pull on the power cord but always on the plug itself.
- The outlet should always be near the device and easily accessible.
-  Power supply cords should be routed so that they are not likely to be walked on or pinched by items 

placed upon or against them.

If the power supply cord is damaged, unplug the device. Using the device with a damaged power supply cord 
may expose your device to electric shocks or other hazards. Verify the condition of the power supply cords 
once in a while. Contact your dealer or service center for replacement if damaged.

•  CONNECTIONS: All inputs and outputs (except for the power input) are Safety Extra Low Voltage (SELV) 
circuits as defined in UL/IEC 60950-1.

•  SERVICING: Do not attempt to service this product yourself by opening or removing covers and screws 
since it may expose your device to electric shocks or other hazards. Refer all problems to qualified service 
personnel. You may lose warranty when you open the unit.

•  OPENINGS: Never push objects of any kind into this product through the openings. If liquids have been 
spilled or objects have fallen into the device, unplug it immediately and have it checked by a qualified 
technician.

4.1 Safety instructions

4.1.1 English
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4.1.2 French

Afin de mieux comprendre le fonctionnement de cet appareil nous vous conseillons de bien lire toutes les  
consignes de sécurité et de fonctionnement avant utilisation. Conservez les instructions de sécurité et de 
fonctionnement afin de pouvoir les consulter ultérieurement. Respectez toutes les consignes marquées dans la 
documentation, sur le produit et sur ce document.

•  ATTENTION : Afin de prévenir tout risque de choc électrique et d’incendie, ne pas exposer cet appareil à la 
pluie, à l’humidité ou à des sources de chaleur intense.

•  INSTALLATION : Veillez à assurer une circulation d’air suffisante pour éviter toute surchauffe à l’intérieur de 
l’appareil. Ne placez pas l’appareil sur ou à proximité d’une surface textile susceptible d’obstruer les orifices de 
ventilation. N’installez pas l’appareil à proximité de sources de chaleur comme un radiateur ou une poche d’air 
chaud, ni dans un endroit exposé au rayonnement solaire direct, à des poussières excessives, à des vibrations 
ou à des chocs mécaniques. Ceci pourrait provoquer un mauvais fonctionnement et un accident.

•  ALIMENTATION : Ne faire fonctionner l’appareil qu’avec la source d’alimentation indiquée sur l’appareil. 
Les appareils doivent être obligatoirement connectés sur une source équipée d’une mise à la terre efficace. 
En aucun cas cette liaison de terre ne devra être modifiée, contournée ou supprimée. Raccordement des 
équipements à l’alimentation principale doit être postérieur au disjoncteur de branchement de l’installation 
électrique du bâtiment.

•  CORDON D’ALIMENTATION : Les appareils sont équipés d’un cordon d’alimentation détachable, la mise 
hors tension se fait en débranchant ce cordon de l’appareil. L’appareil possède un interrupteur en face 
arrière, appuyez dessus pour éteindre l’appareil.

Attention :  le cordon d’alimentation constitue le seul moyen de débrancher l’appareil totalement de 
l’alimentation secteur. Pour être certain que l’appareil n’est plus alimenté, ce cordon doit être 
débranché de la prise murale.

Appliquer les consignes suivantes :
-  Le matériel relié à demeure au réseau, doit avoir un dispositif de sectionnement facilement accessible 

qui doit être incorporé à l’extérieur de l’appareil.
-  Débrancher le cordon d’alimentation de la prise murale si vous prévoyez de ne pas utiliser l’appareil 

pendant quelques jours ou plus.
- Pour débrancher le cordon, tirez-le par la fiche. Ne tirez jamais sur le cordon proprement dit.
- La prise d’alimentation doit se trouver à proximité de l’appareil et être aisément accessible.
- Ne laissez pas tomber le cordon d’alimentation et ne posez pas d’objets lourds dessus.

Si le cordon d’alimentation est endommagé, débranchez-le immédiatement de la prise murale. Il est 
dangereux de faire fonctionner un appareil avec un cordon endommagé ; un câble abîmé peut provoquer un 
risque d’incendie ou un choc électrique. Vérifiez le câble d’alimentation de temps en temps. Contactez votre 
revendeur ou le service après-vente pour un remplacement.

•  CONNEXIONS : Toutes les entrées et sorties (exceptée l’entrée d’alimentation) sont des circuits de très 
basse tension de sécurité (TBTS) tels que définis dans UL / IEC 60950-1.

•  RÉPARATION ET MAINTENANCE : L’utilisateur ne doit en aucun cas essayer de procéder aux opérations de 
dépannage, car l’ouverture des appareils par retrait des capots ou de toutes autres pièces constituant les 
boîtiers ainsi que le dévissage des vis apparentes à l’extérieur, risquent d’exposer l’utilisateur à des chocs 
électriques ou autres dangers. Contactez le service après-vente, votre revendeur ou adressez-vous à un 
personnel qualifié uniquement. L’ouverture de l’appareil provoque la perte de la garantie.

•  OUVERTURES ET ORIFICES : Les appareils peuvent comporter des ouvertures (aération, fentes, etc...), 
veuillez ne jamais y introduire d’objets et ne jamais obstruer ses ouvertures. Si un liquide ou un objet 
pénètre à l’intérieur de l’appareil, débranchez immédiatement l’appareil et faites-le contrôler par un 
personnel qualifié avant de le remettre en service.

4.1.2 French
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4.1.3 Italian

Allo scopo di capire meglio il funzionamento di questa apparecchiatura vi consigliamo di leggere bene 
tutti i consigli di sicurezza e di funzionamento prima dell’utilizzo. Conservare le istruzioni di sicurezza e di 
funzionamento al fine di poterle consultare ulteriormente. Seguire tutti i consigli indicati su questo manuale 
e sull’apparecchiatura.

•  ATTENZIONE: Al fine di prevenire qualsiasi rischio di shock elettrico e d’incendio, non esporre l’apparecchiatura 
a pioggia, umidità e a sorgenti di eccessivo calore.

•  INSTALLAZIONE: Assicuratevi che vi sia una sufficiente circolazione d’aria per evitare qualsiasi 
surriscaldamento all’interno dell’apparecchiatura. Non collocare l’apparecchiatura in prossimità o su 
superfici tessili suscettibili di ostruire il funzionamento della ventilazione. Non installate l’apparecchiatura 
in prossimità di sorgenti di calore come un radiatore o una fuoruscita d’aria calda, né in un posto esposto 
direttamente ai raggi del sole, a polvere eccessiva, a vibrazioni o a shock meccanici. Ció potrebbe provocare 
un erroneo funzionamento e un incidente.

•  ALIMENTAZIONE: Far funzionare l’apparecchiatura solo con la sorgente d’alimentazione indicata 
sull’apparecchiatura. Le apparecchiature queste devono essere obbligatoriamente collegate su una sorgente 
fornita di una efficiente messa a terra. In nessun caso questo collegamento potrà essere modificato, sostituito 
o eliminato. Connessione delle apparecchiature alla rete elettrica deve essere successiva interruttore di 
circuito dell’impianto dell’edificio

•  CAVO DI ALIMENTAZIONE: Il dispositivo è dotato di un cavo di alimentazione removibile, per rimuovere 
alimentazione scollegarlo dalla Presa. L’interruttore di accensione e’ disponibile sul pannello posteriore, 
posizionarlo su OFF per spegnere il dispositivo.

Attenzione: il cavo di alimentazione è il solo modo di disconnettere l’apparecchio dell’alimentazione. Per 
assicurarsi che totalemente l’apparecchio non è più collegato, il cavo deve essere disconesso della presa 
murale.
Seguire le instruzioni seguenti:

-  Il materiale collegato a residenza alla rete, deve avere un dispositivo di sezionamento facile da 
raggiongere eche deve essere inserito all’esterno del apparecchio.

- Disconnettere l’apparecchiatura dalla presa murale se si prevede di non utilizzarla per qualche giorno.
- Per disconnettere il cavo tirare facendo forza sul connettore.
-  La presa d’alimentazione deve trovarsi in prossimità dell’apparecchiatura ed essere facilmente 

accessibile.
-  Non far cadere il cavo di alimentazione né appoggiarci sopra degli oggetti pesanti. Se il cavo di 

alimentazione é danneggiato, spegnere immediatamente l’apparecchiatura.

E’ pericoloso far funzionare questa apparecchiatura con un cavo di alimentazione danneggiato, un cavo 
graffiato puó provocare un rischio di incendio o uno shock elettrico. Verificare il cavo di alimentazione spesso. 
Contattare il vostro rivenditore o il servizio assistenza per una sostituzione.

•  CONNESSIONE: Tutti gli ingressi e le uscite (tranne che per la potenza in ingresso) sono bassissima tensione 
di sicurezza (SELV) circuiti definiti UL / IEC 60950-1.

•  RIPARAZIONI E ASSISTENZA: L’utilizzatore non deve in nessun caso cercare di riparare l’apparecchiatura, 
poiché con l’apertura del coperchio metallico o di qualsiasi altro pezzo costituente la scatola metallica, 
nonché svitare le viti che appaiono esteriormente, poiché ció puó provocare all’utilizzatore un rischio di 
shock elettrico o altri rischi. Qualora si apra l’unita’, la garanzia non sara’ più’ valida.

•  APERTURE DI VENTILAZIONE: Le apparecchiature possono comportare delle aperture di ventilazione, si 
prega di non introdurre mai oggetti o ostruire le sue fessure. Se un liquido o un oggetto penetra all’interno 
dell’apparecchiatura, disconnetterla e farla controllare da personale qualificato prima di rimetterla in 
servizio.

4.1.3 Italian
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4.1.4 German

Um den Betrieb dieses Geräts zu verstehen, raten wir Ihnen vor der Inbetriebnahme alle Sicherheits und 
Betriebsanweisungen genau zu lesen. Diese Sicherheits- und Betriebsanweisungen für einen späteren Gebrauch 
sicher aufbewahren. Alle in den Unterlagen, an dem Gerät und hier angegebenen Sicherheitsanweisungen 
einhalten.

•  ACHTUNG: um jegliches Risiko eines Stromschlags oder Feuers zu vermeiden, das Gerät nicht Regen, 
Feuchtigkeit oder intensiven Wärmequellen aussetzen.

•  EINBAU: Eine ausreichende Luftzufuhr sicherstellen, um jegliche Überhitzung im Gerät zu vermeiden. Das 
Gerät nicht auf und in Nähe von Textiloberflächen, die Belüftungsöffnungen verschließen können, aufstellen. 
Das Gerät nicht in Nähe von Wärmequellen, wie z.B. Heizkörper oder Warmluftkappe, aufstellen und es 
nicht dem direkten Sonnenlicht, übermäßigem Staub, Vibrationen oder mechanischen Stößen aussetzen. 
Dies kann zu Betriebsstörungen und Unfällen führen.

•  STROMVERSORGUNG: Das Gerät nur mit der auf dem Gerät bezeichnete Stromquelle betreiben. Gerät mit 
geerdeter Hauptstromversorgung muss an eine Stromquelle mit effizienter Erdung angeschlossen werden. 
Diese Erdung darf auf keinen Fall geändert, umgangen oder entfernt werden. Anschluss von Geräten ans 
Stromnetz muss nach Abzweigschalter des Gebäudes Installation

•  NETZKABEL: Das Gerät ist mit einem lösbaren Netzkabel ausgestattet ; um es völlig vom Netz zu trennen, 
ziehen Sie bitte das Netzkabel aus der Kaltgerätebuchse. Des Weiteren befindet sich auf der Rückseite ein 
Schalter, mit dem das Gerät ausgeschaltet werden kann.

Achtung: Das Netzkabel stellt die einzige Möglichkeit dar, das Gerät vollständig vom Netzanschluss zu trennen. 
Um sicherzustellen, dass das Gerät nicht mehr versorgt wird, muss dieses Kabel aus der Netzsteckdose 
ausgesteckt werden.

Bitte beachten Sie die folgenden Hinweise:
-  Wenn Geräte dauerhaft am Netz bleiben, müssen sie über eine leicht zugängliche Trennvorrichtung 

verfügen, die außen am Gerät angebracht sein muss.
- Das Kabel mittels dem Stecker herausziehen. Niemals am Stromkabel selbst ziehen.
- Die Steckdose muß sich in der Nähe des Geräts befinden und leicht zugänglich sein.
- Das Stromkabel nicht fallen lassen und keine schweren Gegenstände auf es stellen.

Wenn das Stromkabel beschädigt ist, das Gerät sofort abschalten. Es ist gefährlich das Gerät mit einem 
beschädigten Stromkabel zu betreiben; ein abgenutztes Kabel kann zu einem Feuer oder Stromschlag 
führen. Das Stromkabel regelmäßig untersuchen. Für den Ersatz, wenden Sie sich an Ihren Verkäufer oder 
Kundendienststelle.

•  ANSCHLÜSSE: Alle Eingänge und Ausgänge (mit Ausnahme der Stromversorgung) sind Safety Extra Low 
Voltage (SELV) Schaltungen wie in UL / IEC 60950-1 definiert.

•  REPARATUR UND WARTUNG: Der Benutzer darf keinesfalls versuchen das Gerät selbst zu reparieren, die 
Öffnung des Geräts durch Abnahme der Abdeckhaube oder jeglichen anderen Teils des Gehäusessowie die 
Entfernung von außen sichtbaren Schrauben zu Stromschlägen oder anderen Gefahren für den Benutzer 
führen kann. Wenden Sie sich an Ihren Verkäufer, Ihre Kundendienststelle oder an qualifizierte Fachkräfte. 
Das Öffnen des Gehäuses führt zum Verlust der Garantie.

•  ÖFFNUNGEN UND MUNDUNGEN: Die Geräte können über Öffnungen verfügen (Belüftung, Schlitze, usw.). 
Niemals Gegenstände in die Öffnungen einführen oder die Öffnungen verschließen. Wenn eine  Flüssigkeit 
oder ein Gegenstand in das Gerät gelangt, den Stecker herausziehen und es vor einer neuen Inbetriebnahme 
von qualifiziertem Fachpersonal überprüfen lassen.

4.1.4 German
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4.1.5 Spanish

Para comprender mejor el funcionamiento de este aparato, le recomendamos que le acuidadosamente todas 
las consignas de seguridad y de funcionamiento del aparato antes de usarlo. Conserve las instrucciones de 
seguridad y de funcionamiento para que pueda consultarlas posteriormente. Respete todas las consignas 
indicadas en la documentación, relacionadas con el producto y este documento.

•  CUIDADO: Para prevenir cualquier riesgo de choque eléctrico y de incendio, no exponga este aparato a la 
lluvia, a la humedad ni a fuentes de calorintensas.

•  INSTALACIÓN: Cerciórese de que haya una circulación de aire suficiente para evitar cualquier 
sobrecalentamiento al interior del aparato. No coloque el aparato cerca ni sobre una superficie textil que 
pudiera obstruir los orificios de ventilación. No instale el aparato cerca de fuentes de calor como radiador o 
boca de aire caliente, ni en un lugar expuesto a los rayos solares directos o al polvo excesivo, a las vibraciones 
o a los choques mecánicos. Esto podría provocar su mal funcionamiento o un accidente.

•  ALIMENTACIÓN:  Ponga a funcionar el aparato únicamente con la fuente de alimentación que se indica en 
el aparato. Los aparatos deben estar conectados obligatoriamente a una fuente equipada con una puesta 
a tierra eficaz. Por ningún motivo este enlace de tierra deberá ser modificado, cambiado o suprimido. 
Conexión del equipo a la red eléctrica debe ser posterior del interruptor de circuitos derivados de la 
instalación del edificio

•  CABLE DE CORRIENTE: El equipo se suministra con un cable de corriente  si desconectamos el cable dejamos 
al equipo sin alimentación. Un interruptor situado en la trasera de la unidad, permite apagar el equipo.

Atención:  El cable de alimentación constituye el único medio de desconectar el aparato totalmente de la 
red eléctrica. Para estar seguro de que el aparato no está más alimentado, este cable debe de ser 
desconectado de la toma de corriente.

Aplicar las siguientes consignas:
-  El material conectado a residencia a la red informática, debe de tener un dispositivo de seccionamiento 

fácilmente accesible que debe de ser incorporado al exterior del aparato.
- Desconectar el aparato del enchufe mural si no piensa utilizarlo durante varios días.
- Para desconectar el cable, tire de la clavija. No tire nunca del cable propiamente dicho.
- El enchufe de alimentación debe estar cerca del aparato y ser de fácil acceso.
- No deje caer el cable de alimentación ni coloque objetos pesados encima de él.

Si el cable de alimentación sufriera algún daño, ponga el aparato inmediatamente fuera de tensión. Es 
peligroso hacer funcionar este aparato con un cable averiado, ya que un cable dañado puede provocar un 
incendio o un choque eléctrico. Verifique el estado del cable de alimentación de vez en cuando. Póngase en 
contacto con su distribuidor o con el servicio de posventa si necesita cambiarlo.

•  CONEXIONES: Todas las entradas y salidas (a excepción de la entrada de alimentación) son de tensión extra 
baja de seguridad (SELV) circuitos definidos en UL / IEC 60950-1.

•  REPARACIÓN Y MANTENIMIENTO: Por ningún motivo, el usuario deberá tratar de efectuar operaciones 
de reparación, ya que si abre los aparatos retirando el capó o cualquier otra pieza que forma parte de las 
cajas o si destornilla los tornillos aparentes exteriores, existe el riesgo de producirse una explosión,choques 
eléctricos o cualquier otro incidente. Contacte el servicio de posventa, a su distribuidor o dirigirse con 
personal cualificado únicamente. La unidad pierde la garantía si esta ha sido abierta.

•  ABERTURAS Y ORIFICIOS: Los aparatos pueden contener aberturas (aireación, ranuras, etc.). Nointroduzca 
allí ningún objeto ni obstruya nunca estas aberturas. Si un líquido o un objeto penetra al interior del aparato, 
desconéctelo y hágalo revisar por personal cualificado antes de ponerlo nuevamente en servicio.

4.1.5 Spanish
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4.2 Unpacking and inspection

• 1 x Eikos² (EKS550)
• 1 x Power supply cord
• 1 x Ethernet cross cable (for device update)
• 1 x Remote Control Software (RCS²)*
• 1 x Set of 6 audio 5-pin screw terminals
• 1 x Front rack ears (the parts are stowed in the packaging foam)
• 1 x User manual (PDF)*
• 1 x Quick start guide*

* User manual, quick start guide and the RCS² are available on www.analogway.com

Before racking and plugging any inputs and outputs, it is advised to power on the unit. Should you encounter 
any issue, you must contact immediately your local distributor or dealer, or closest Analog Way technical 
support offices (see chapter: 12. Contact information).

Tabletop mounting:  The Eikos² can be used directly on a table; the unit is equipped with 4 handy anti-slip 
rubber feet.

Rack mounting:  The Eikos² is compatible with a 19” enclosure. Please follow the instructions below to install 
the device in a 19” rack.

Place the device in your rack. Attach the device to the rack by screwing 2 front ears on it (screws not included).
Rear fixing is also recommended, in particular for permanent installations. 
Connect all of the cables of the device and attach them to the rack with the help of tie wraps.

IMPORTANT:
-  The openings in the side of the device are for cooling. Do not cover these openings to avoid blocking air 

circulation.
- Be sure that no weight in excess of 2 kg (4.4 Lbs.) is added onto the Eikos².
- The maximum ambient operating temperature should not exceed 40°C (104°F).
-  The rack and all mounted equipment in it must be reliably grounded according to national and/or local 

electrical standards.

4.2 Unpacking and inspection

4.3 Rack mount information

Dismantling front handles of the device could invalidate warranty on after-sales services of 
your Eikos². It is strongly advised to avoid using front handles as rests for your Eikos², they are 
designed for manipulation purposes only.

If required, front handles of the device can be dismantled, but with caution. The original screws removed 
must not be reintroduced to their location without handles in place. Substantial damages can occur, 
including risk of electric shock from the main voltage. Only M4x12mm screws can be used. They are 
supplied with the unit.
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4.4 Cable and adaptator information

A large choice of cables and adaptors are compatible with the Eikos². Please refer to the hardware specifications 
chapter to find the most suitable cables for your operations. 

For each type of signal, here are the levels and the impedance accepted by the Eikos².

4.4 Cable and adaptor information

4.5 Hardware specifications

4.5.1 Signal descriptions

Type Levels Impedance

Composite 0,7 Vpp + 0,3 Vpp 75 Ω

S. Video Y = 0,7 Vpp + 0,3 Vpp
C = 0,7 Vpp 75 Ω

YUV Y = 0,7 Vpp + 0,3 Vpp
U = 0,7 Vpp
V = 0,7 Vpp

75 Ω

RGsB R = 0,7 Vpp
G = 0,7 Vpp + 0,3 Vpp

B = 0,7 Vpp
75 Ω

RGBS

R, G, B = 0,7 Vpp R, G, B = 75 Ω

S = 0,3 Vpp 75 Ω
or

S = TTL

Type Levels Impedance

YUV Y = 0,7 Vpp + 0,3 Vpp
U = 0,7 Vpp
V = 0,7 Vpp

75 Ω

RGsB R = 0,7 Vpp
G = 0,7 Vpp + 0,3 Vpp

B = 0,7 Vpp
75 Ω

RGBS

R, G, B = 0,7 Vpp R, G, B = 75 Ω

S = 0,3 Vpp 75 Ω
or

S = TTL

Type Characteristics

SD-SDI YUV - 10 bits – 4.2.2 - 270 Mb/s
No payload ID management

Only A-level type

DVI RGB ou YUV – 8 bits – 4.4.4 – 16/235 - TMDS

HDMI RGB or YUV – 8 bits – 4.4.4 or 4.2.2 
– 16/235 – TMDS

Type Levels Impedance

YUV Y = 0,7 Vpp ±0,3 Vpp
U = 0,7 Vpp ±0,3 Vpp
V = 0,7 Vpp ±0,3 Vpp

75 Ω

RGsB R = 0,7 Vpp ±0,3 Vpp
G = 0,7 Vpp ±0,3 Vpp
B = 0,7 Vpp ±0,3 Vpp

75 Ω

Type Characteristics

HD-SDI YUV - 10 bits – 4.2.2 – 1,485Gb/s and 
1,485/1.001Gb/s
Only A-level type

Input and output payload ID management 
for HDTV format only

3G-SDI YUV - 10 bits – 4.2.2 – 2,97Gb/s and 
2,97/1.001Gb/s

Only A-level type
Input and output payload ID management 

for HDTV format only

DVI RGB or YUV – 8 bits – 4.4.4 – 16/235 - TMDS

HDMI RGB or YUV – 8 bits – 4.4.4 or 4.2.2
– 16/235 – TMDS

Type Characteristics

DVI RGB or YUV – 8 bits – 4.4.4 – 16/235 - TMDS

HDMI RGB or YUV – 8 bits – 4.4.4 or 4.2.2
– 16/235 – TMDS

Analog SDTV

Analog EDTV

Digital SDTV

Analog HDTV

Digital HDTV

Digital EDTV

These formats are compatible with bi-level and tri-
level sync on 1 or 3 wires.
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4.5.2 Supported video formats

The Eikos² can support all the following video formats:

Important:  The maximum pixel clock frequency is 165 MHz. Supported formats include 1920x1200 @ 60hz 
RB, 1600x1200 @60hz RB, 2048x1152 @60hz RB. 

The Eikos² inputs support GTF (version 1.1), CVT (version 1.1) and DMT (version 1.0 rev 12) standards. All 
others non-standard formats are supported via the custom format capability of the framework.

4.5.2 Supported video formats

4.5.3 Computer formats

4.5.4 Input Computer formats

Type Levels Impedance

RGsB R = 0,7 Vpp
G = 0,7 Vpp + 0,3 Vpp

B = 0,7 Vpp
75 Ω

RGBS
R, G, B = 0,7 Vpp R, G, B = 75 Ω

S = 0,3 Vpp 75Ω or S = TTL

RGBHV
R, G, B = 0,7 Vpp R, G, B = 75 Ω

H = TTL and V = TTL

Type Characteristics

DVI RGB – 8 bits – 4.4.4 – 0/255 - TMDS

HDMI® RGB or YUV – 8 bits – 4.4.4 or 4.2.2
– 0/255 – TMDS

Analog computer Digital computer

Standard Size Vertical frequency Horizontal frequency

NTSC 525/480i 59.94Hz/60Hz 15,735 KHz

PAL 625/576i 50Hz 15.625 KHz

SECAM 625/576i 50Hz 15.625 KHz

SDTV formats

Standard Size Vertical frequency Horizontal frequency

480p 525/480p 59.94Hz/60Hz 31.47 KHz

576p 625/576p 50Hz 31.25 KHz

EDTV formats

Standard Size Vertical frequency

720p 1280 x 720 23.97Hz/24Hz/25Hz/29,97Hz/30Hz/50Hz/59.94Hz/60Hz

1035i 1920 x 1035 59.94Hz/60Hz

1080i 1920 x 1080 50Hz/59.94Hz/60Hz

1080sF 1920 x 1080 50Hz/59.94Hz/60Hz

1080p 1920 x 1080 23.97Hz/24Hz/25Hz/29,97Hz/30Hz/50Hz/59.94Hz/60Hz

HDTV formats

Format Size Vertical frequency

DCDM 2048 x 1080 24Hz

Cinema formats
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4.5.5 Output computer formats

The Eikos² outputs support GTF (version 1.1), CVT (version 1.1) and DMT (version 1.0 rev 12) standards. Other 
non-standard formats are supported via the custom format capability of the framework.
The Eikos² offers a list of pre-defined output formats. The list of output formats is always displayed from in-
creasing number of pixels per line and then number of lines.

The Eikos² offers 10 seamless inputs. Some inputs contain several plugs.
A plug corresponds to a socket or connector on the rear panel. 
The following types of plugs are available on the rear panel:
- HDMI 
- Single DVI-D (HDMI compatible),
- 3G/HD/SD-SDI (BNC),
- Universal Analog (HD-15)

4.5.5 Output Computer formats

Format Size Aspect ratio Frequency
50 Hz          60 Hz

VGA 640x480 4/3 Yes Yes
WVGA 848x480 16/9 Yes Yes
SVGA 800x600 4/3 Yes Yes
720p 1280x720 16/9 Yes Yes
XGA 1024x768 4/3 Yes Yes

WXGA 1280x768 5/3 Yes Yes
SWXGA 1360x768 16/9 Yes Yes

1366x768 1366x768 16/9 Yes Yes
WXGA2 1280x800 16/9 Yes Yes

SWXGAP 1366x800 5/3 Yes Yes
1152x864 4/3 Yes Yes

900p 1440x900 16/10 Yes Yes
1440x900 3/2 Yes Yes
1600x900 16/9 Yes Yes
1280x960 4/3 Yes Yes

SXGA 1280x1024 5/4 Yes Yes
1360x1024 4/3 Yes Yes

SXGAP 1400x1050 5/3 Yes Yes

4.6 Input specifications

Format Size Aspect ratio Frequency
50 Hz          60 Hz

WSXGAP 1680x1050 16/9 Yes Yes
1080p 1920x1080 16/9 Yes Yes

2K 2048x1080 17/9 Yes Yes
UXGA 1600x1200 4/3 Yes Yes

WUXGA 1920x1200 16/9 Yes Yes
2048x1152 16/9 Yes Yes
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4.6 Input specifications

The Eikos² uses an HDMI plug with a standard mounting 
screw above the connector.  Please see the diagram below.
This hole is occupied by a Torx10 screw when you receive 
the unit. If desired, this screw can be removed and 
replaced by a compatible aftermarket HDMI plug locking 
mechanism to ensure a secure HDMI connection. This 
threaded hole should not be left empty.

This hole is used by a TX10 screw when you receive the unit, if you wish to use an HDMI cable with a security 
fixing screw you can take this screw off and use your own in order to insure good fixing of your HDMI plug.

Please take a look at the accepted formats regarding the input plug type:

WARNING: Only the video and audio signal is processed for the HDMI®, and 3G/HD/SD-SDI inputs; other em-
bedded auxiliary features are not supported or passed through. The embedded audio is processed. All other 
HDMI® features such as: HDMI Ethernet Channel, Audio Return Channel, 3D, 4K, Content Type, Deep Color 
and x.v.Color are NOT supported.

Each input can display only one active plug at a time. It is instantly available on the device and can be dis-
played simultaneously on many layers or outputs, with different sizes and positions. 

Plug Type Formats Signals

Universal Analog Input SDTV - EDTV - HDTV - Computer Analog SDTV - Analog EDTV - Analog HDTV - Analog Computer

DVI-D Input SDTV - EDTV - HDTV - Computer Digital SDTV - Digital EDTV - Digital HDTV - Digital Computer

HDMI Input SDTV - EDTV - HDTV - Computer Digital SDTV - Digital EDTV - Digital HDTV - Digital Computer

3G/HD/SD-SDI Input SDTV - HDTV Digital SDTV - Digital HDTV

Standard Size HD-15 3G-SDI HDMI Single-Link
DVI-D

NTSC 525/480i Yes Yes Yes No
PAL 625/576i Yes Yes Yes No

SECAM 625/576i Yes Yes Yes No
EDTV 480p 525/480p Yes No Yes Yes
EDTV 576p 625/576p Yes No Yes Yes
HDTV 720p 1280x720 Yes Yes Yes Yes
HDTV 1035i 1920x1035 Yes Yes Yes Yes
HDTV 1080i 1920x1080 Yes Yes Yes Yes
HDTV 1080p 1920x1080 Yes Yes Yes Yes
HDTV 1080sF 1920x1080 Yes Yes Yes Yes
HDTV 1080p 1920x1080 Yes Yes Yes Yes
HDTV DCDM 2048x1080 No Yes No No

VGA 640x480 Yes No Yes Yes
800x480 800x480 Yes No Yes Yes
WVGA 848x480 Yes No Yes Yes
SVGA 800x600 Yes No Yes Yes

1280x600 1280x600 Yes No Yes Yes
720p RGB 1280x720 Yes No Yes Yes

XGA 1024x768 Yes No Yes Yes
WXGA 1280x768 Yes No Yes Yes

SWXGA 1360x768 Yes No Yes Yes

M3x0,5 mm

27 mm
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4.7 Output specifications

Note:
1) Reduced Blanking

Standard Size HD-15 3G-SDI HDMI Single-Link
DVI-D

1366x768 1366x768 Yes No Yes Yes
800p RGB 1280x800 Yes No Yes Yes
SWXGA+ 1366x800 Yes No Yes Yes

1152x864 1152x864 Yes No Yes Yes
900p RGB 1440x900 Yes No Yes Yes
1600x900 1600x900 Yes No Yes Yes
960p RGB 1280x960 Yes No Yes Yes

SXGA 1280x1024 Yes No Yes Yes
1360x1024 1360x1024 Yes No Yes Yes

DILA4/3 1364x1024 Yes No Yes Yes
SXGA+ 1400x1050 Yes No Yes Yes

WSXGA+ 1680x1050 Yes No Yes Yes
1080p RGB 1920x1080 Yes1 No Yes Yes

2K 2048x1080 Yes1 No Yes Yes
Q WXGA 2048x1152 Yes1 No Yes Yes

UXGA 1600x1200 Yes1 No Yes Yes
WUXGA 1920x1200 Yes1 No Yes Yes

The Eikos² has two standard outputs.
The standard output contains:
- Analog Computer/Video (HD15),
-  HDMI output over a DVI-I connector or DVI-I output (DVI-Analog and DVI-Digital).

4.7 Output specifications

4.7.1 Standard output

VGA

DVI-I
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4.7.2 Video output

The Eikos² has one video output.
This video output contains:
- 3G/HD/SD-SDI (BNC),
- Analog SDTV (4 × BNC: Composite, YC, YUV, RGBS).

Please see the formats available on the output:

Please see the output formats of the monitoring output:

Please note that SDTV and EDTV are not available on the standard output but only on the video output module.

4.7.2 Video output

Output Type Format Signal

Analog Computer/Video Ouput HDTV
 Computer

Analog HDTV
Analog Computer

DVI-I Output HDTV 
Computer

Digital HDTV
Digital Computer

Output Type Format Signal

Video Y/C Output SDTV Analog SDTV

Video Y Pb Pr Output SDTV Analog SDTV

Video RGBSTTL Output SDTV Analog SDTV

SD-HD-3G-SDI Output SDTV
HDTV

Digital SDTV
Digital HDTV

A standard RS232 interface is available through a DB9 female connector:
- It permits controlling the device
- It permits updating the device
Data Rate: 1200 to 115200 Bauds, 8 data bits, 1 stop bit, no parity bit, no flow control by default.
DTR & RTS needed for firmware upgrade.

4.8 Communication specifications

4.8.1 Serial interface
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4.8.2 LAN interface

4.8.2.1 Protocol

4.8.2.2 IP address

4.8.2 LAN interface

Protocol Availability

TCP Yes

UDP Yes

Address allocation Availability

Static user defined address Yes

A standard LAN interface is available through a RJ-45 connector
- It permits controlling the device
- It permits transferring configuration
- It permits connectivity with the RCS² application
- It permits updating the device

Default IP address: 192.168.2.140
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4.9 Environmental specifications

• Cooling air flows from right side to left side.
• Max ambient operating temperature: < 40°C (< 104°F).
• Operating temperature: 0 to +40°C / +32°F to +104°F
• Storage temperature: -40 to +70°C / -40°F to +158°F
• Operating humidity: 10 to 80% (non condensing)
• Input voltage range: 100-240 VAC autosensing, 50/60 Hz
• Typical consumption: 110 W

4.9 Environmental specifications

Dimensions:

 D 15.75’’x W 19’’ x H 3.46’’ with rack mount and handles
  D 400 mm x W 483 mm x H 88 mm

  D 14.17’’x W 17.3’’ x H 3.46’’ without rack mount and handles
  D 360 mm x W 440 mm x H 88 mm

Weight:

 6,3kg / 13.9 lb 
(Compatible with a Standard 19” 
rack, Height = 2 U)

ELECTRICAL SECURITY:
• IEC 60950-1:2005 (2nd Edition); Am 1:2009
•  EN 60950-1:2006 + A1:2010 + A11:2009 + A12:2011, CSA C22.2; National Differences specified in the CB 

Test Report
• UL listed (Canada & US)

ELECTROMAGNETIC COMPATIBILITY:
• IEC 61000-3-2 (2009)
• IEC 61000-3-3 (2008)
• CISPR22 (2008)
• CISPR24 (2010)
• FCC Part15 of 2012
• IECS-003 of August 2012

ENVIRONMENT:
• RoHS
• WEEE

USE/TRANSPORT:
•  ETS 300 019-2-2: Environmental conditions and environmental tests for telecommunications equipment ; 

Part 2-2 : specification of environmental tests ; Transportation ; Specification T 2.3: Public transportation
•  ETS 300 019-2-3: Environmental conditions and environmental tests for telecommunications equipment ; 

Part 2-3 : specification of environmental tests ; Stationary use at weather protected locations ; Specification 
T 3.1 and T 3.1 E: Temperature-controlled locations

If your device should lose power unexpectedly, you may lose any unsaved settings.
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4.10 HDCP management

Keys’ checking is performed according to the most restrictive condition among the 2 following ones:
- Every 2 seconds
- Every 128 frames

HDCP protected content can be displayed only on HDCP protected outputs or displays. Therefore, whenever 
an HDCP protected source is placed into a layer routed to a non-protected output, the Eikos² will not output 
the protected content on this non-protected output, and the layer will be grayed.
If possible, the Eikos² will allow to display all other non-protected contents, otherwise the entire output will 
be muted until the protected content is no longer routed.

The HDCP negotiation can be enabled or disabled on all HDCP inputs.

The HDCP negotiation can be enabled or disabled on all HDCP outputs.
The Eikos² can manage HDCP repeaters on its outputs: up to 32 display devices can authenticate simultaneously 
on each output.

In order to permit quick identification of all the HDCP operations on the device, the Eikos² provides a full set 
of status summary to help the user with the HDCP management:
- A front panel menu that displays all the general HDCP status of all inputs and outputs

4.10.3 Keys’ checking

4.10.4 Output management

4.10.5 HDCP Classification

4.10.6 Status

Class Support

HDCP Receiver Yes

HDCP Transmitter Yes

HDCP Repeater No

HDCP Receiver

HDCP Transmitter

The input HDCP detection is managed by the input components according to HDCP specification.

The Eikos² manages the output HDCP detection according to one of the following criteria:
- Hot plug,
- 3-second period attempt.

4.10 HDCP management

4.10.1 Input HDCP detection

4.10.2 Output HDCP detection
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5.1.1 Rear panel

1. Power supply: 100-240 VAC 2.5A 50/60HZ / FUSE F4A 250 VAC; internal, autoswitchable; 110W 

2. 3G/HD/SD-SDI: inputs #1 to #4

3. S/PDIF: audio inputs #1 to #2

4. MCO male connector: for audio inputs (balanced) #1 to #4

5. MCO male connector: for audio outputs (balanced) #1 to #2 

6. S/PDIF: audio outputs #1 to #2

7. Video out connectors:  - 1 x BNC-F: 3G/HD/SD-SDI (with audio embedded)
    - 3 x BNC-F: Y-Cb-Cr
    - 1 x BNC-F: Composite video PAL/NTSC

8. Universal Analog Computer TV/HDTV: inputs #1 to #4

9.  DVI connectors: DVI-D inputs #1 to #4. Capability to receive digital audio signal from HDMI connector via 

an adaptor (HDMI-compatible) 

10. Ethernet plug

11. HDMI connectors: HDMI inputs #3 to #6. Digital audio compliant

12. Communication port: communication port with DB9 female connector

13. Universal Analog Computer TV/HDTV: HD15 outputs #1 to #2

14.  DVI connectors: DVI-I outputs #1 to #2. Capability to transmit digital audio signal towards a HDMI 

connector via an adaptor (HDMI-compatible)

5. CONNECTING THE EIKOS²
5.1 Description

5.1.1 Rear panel

1 2 3 4 5 6 7

9 10 128 11 1413
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5.1.2 Front panel

5.1.2 Front panel

1 2 3 4 5 6

15119 1210
13

148

7

1. Front panel display: 4-line VFD

2. Menu scroll knob

3. Layer selection:  - Frame: un-scaled layer for still frames
   - Layer A/B/C: scaled positionable layers for live sources
   - Logo 1/2: un-scaled, positionable layer for still logos

4. Matrix mode: #1 to #2: select the output #1 or #2, a layer and a source, then press TAKE

5. Adjustment: adjust layer or logo position, size active layer, zoom active layer

6. Quadravision: W1 to W4: 4 layers with a choice of 8 customized templates

7. Effect: - Cut: select Cut as the current transition type
  - Fade: select Fade as the current transition type
  - User 1 to 4: select as a customized transition

8. On/Off - Stand-by: hold for 3 seconds for stand-by mode

9. Control: Exit/menu: Home menu or back one level - Enter: validate the menu or command

10.  Input selection:  - 1 to 4: access source 1 to 4, display frame/logo 1 to 4
   - HDMI 1/2: access HDMI 1 or HDMI 2
   - SDI 1 to SDI 4: access SDI 1 to SDI 4, display frame/logo 5 to 8
   - Quick Frame: allows to quickly display a foreground frame

11. Function: Preview: display Mosaic Preview - Shift: secondary function selection button

12. Layer: - Black: clear the layer 
  - Freeze: freeze/unfreeze the input selected in the currently selected layer

13. Step Back: recall the last preset into your Preview monitor

14. TAKE: transition the pre-selected sources onto the Program output with the selected effects

15. Preset: P1 to P8: stores and recalls 8 presets available
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6.1 RCS² requirement

6. CONTROLLING THE EIKOS²

6.1 RCS² requirement

6.2 Connecting with the RCS²

The Eikos² can be controlled and operated either via the Front Panel, from your computer via the RCS², or 
via one of our Event Controllers. (Control of the Eikos² can also be integrated into automation and control 
systems, contact your local technical support for more details.)

The RCS2 is an Adobe Air application that runs on your computer.  Before you can 
connect to your device, you must first download and install Adobe Air, then download 
and install the RCS2 on your computer.   
In order to connect the RCS2 to the device, you need to use a LAN connection. Use a 

crossover cable if you connect your computer directly to the unit, or use straight cables if you are connecting 
through a switch or hub. 

Before switching ON the unit, please plug a LAN cable on the rear 
panel into the Ethernet port. Then switch ON the unit.

By default, the network settings on the Eikos² are 
Default IP Address: 192.168.2.140
Default Subnet Mask: 255.255.255.0
Default port: 10500

To be able to connect to this address, your computer will need to 
be configured to use a unique IP address on the same network. If 
this setup will be part of a larger network with other devices, please 
check with your network administrator before plugging these 
devices into the network to avoid any IP address conflicts.
For example, you could assign the following static IP address to your 
computer: 
Example Computer IP address: 192.168.2.50
Example Computer Subnet Mask: 255.255.255.0

To download the Remote Control Software, please visit our website and go into the product section. Then, 
into the download link, please download the RCS² associated to your product. Install it and then open. Here 
is the startup screen.

The recommended requirements are:
- Adobe Air®
- 1Gb Ram
- 200Mb of free space
- 100Mb Network adaptor or above
- 1920x1080 optimized screen resolution
-  1366x768 as the minimum screen resolution. 

Operating system:
- Windows XP SP3 or above
- Mac OS v10.7 or above
- Ubuntu v10 or above
- Linux OS 11 or above

For Linux users:
The RCS² is an Adobe® AIR® application that requires the most recent version of this runtime. As Adobe® AIR® 
is no longer supported for desktop Linux distributions,  please use a dedicated software such as WINE to use 
applications designed for Microsoft Windows on your operating  system.
1. First, install a Microsoft Windows compatibility layer software on your Linux PC.
2. Then install the Adobe® AIR® last release using your emulator
3. Finally, install the RCS² using your emulator.
You are ready to use the RCS².
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6.2 Connecting with the RCS²

In case of difficulties: 
-  Verify that you are using the correct network cable and that it is free from defects. (Crossover or straight 

cable as required.)
-  Check the IP address of both the device and the computer. It must have a unique IP address on the same 

network as your Eikos². You may need to manually configure a static IP address for your computer in your 
computer’s network configuration. 

-  You may need to temporarily disable any other networks on the computer, such as turning off the wifi 
connection.

- Close the RCS².
- Restart the RCS².

Once your computer has established connection, the RCS² control panel will begin to load, and will begin to 
synchronize with the device.  When the small “Sync” icon at the bottom right of the display has turned green, 
the RCS² software is ready to use.

Some computers use an energy saving mode that turns off the network adaptor during pe-
riods of inactivity. To avoid the inconvenience of reconnecting the software during use, please 
ensure your network adaptor remains active by disabling the energy saving mode. 

Enter the IP address of the device and then the remote port.
Click on SET AS DEFAULT if you want the software to remenber 
your configuration.
Click on Connect to start the connection.

Once connected, you have access to this screen: 
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6.3 RCS² top menu

6.3 RCS² top menu

The Setup page is where you will review and modify the device configuration, such as output resolutions, 
input settings, and more.

The Edit mode is the place where you will manage preset creation. You will make input selections, manage your 
inputs, adjust the layer attributes such as size, position, effect, etc. You can save all your screen configurations 
into presets, as well as review and recall them on each individual screen.

The Live mode is the section where you will operate your show. You can quickly recall presets or make input 
selections, as well as setup a sequence of presets that can run continuously with custom durations, or wait 
for user interaction.

6.3.1 Setup

6.3.2 Edit

6.3.3 Live
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7.1 Operating mode

Mixer mode

7. OPERATING THE EIKOS² FROM THE RCS²
7.1 Operating mode

Before you start setting up your Eikos² for the first time, take some time to think about how you will be using 
it. The Eikos² offers a choice of three operating modes, which results in a versatile video production tool for 
live event staging and fixed installation applications.

NOTE:  We recommend resetting the device to its default values every time you set up your shows or events.

This mode allows for a single Eikos² to seamlessly switch any of its 10 analog/digital inputs with any other of 
the inputs, add PIP, titling or logo insertion to the live frame, while previewing your every move before going 
live, to avoid embarrassing errors on your main screen. The Video output of the Eikos² allows to have a copy 
of the full Main screen at a video resolution for recording or broadcasting.

Frame

Layer A

Layer B

Layer C

Logo 1

Quick Frame

Logo 2

Background

Foreground

Go to the setup section to start to set up 
your unit. A Setup assistant is available 
to help you to correctly adjust all basic 
setups of your unit.

7.2 Setup

The device can work in 3 different modes, Mixer mode, Matrix mode or Quadravision mode.

7.2.1 Mode
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7.2.2 Audio

Matrix mode

Quadravision mode

This mode turns your Eikos² into a true 10 x 2 scaled matrix, while preserving seamless switching capabilities.
Program 1 and Program 2 outputs can be set to different resolutions and rates. Switching between any of the 
inputs can be done with the various effects (Cut, Fade, Slides…) and synchronized on both outputs.

This mode allows to display up to four live windows, while preserving seamless switching capabilities (not if 
all 4 layers are displayed). Several templates are available.

In this section, you will setup the audio of your device, you have several modes. In all modes, you have the 
possibility to output the audio in AES3 or SPDIF:

NO AUDIO: the audio of your device is switched off

PRESET MODE: the standard mode of use of the device
You have two possibilities: 
•  Top layer: the sound on the output will follow the audio input of the top 

layer. 
•  Breakaway: when breakaway is activated, the audio on the output is 

memorized into the preset. A change of preset, changes the audio on the 
output. A change of content into a video layer has no effect on the audio.

ROUTING MODE: in this configuration, simply choose an audio input to 
assign it to the output. The audio configuration remains the same during 
the show.

In this example input1 is on out1 and input 2 is on out 2

7.2.2 Audio
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7.2.3 Screens

In the screen configuration, you will find the state of your screen. It indicates the screen resolution, the 
maximum number of layers you can use.

You will find configuration for the Quick Frame and the background color too.
The Quick Frame will be your emergency frame that can be displayed in front of 
every layer. Here, select the frame slot number to be displayed as the Quick Frame.
If you are in Matrix mode, you have 2 screens status.

Into the PREVIEW section, you have the possibility to choose your PREVIEW mode: 

Click on Mosaic to have a Mosaic Preview of all your inputs. Click on Preview to 
simply have the standard Preview with all layer size and position. Remember that 
only 1 layer at the time can be display on the Preview.
PRESET ASPECT: disabling this option disable the Preview indications on your Preview 
monitor, such as the blinking layer wireframe, and source number.
OSD Fields: enable or disable all information about your layer configuration

7.2.3 Screens

7.2.4 Preview

7.2.5 Misc

PRESET TOGGLE: by default, the device will not swap the Program and 
Preview busses during each TAKE. Disabling this option will leave the 
Preview bus unchanged during each TAKE, and only the Program will be 
updated. When this option is enabled, the Preview and Program busses will 
be swapped during each TAKE. 
AUTOTAKE: enable the automatic TAKE. Each time a source is changed on 
preview, it triggers a TAKE to be launched.
DYNAMIC FIT: enable or disable the automatic recognition of black band for 
digital content. The size and the aspect ratio of the layer are automatically 
adapted.

FREEZE MODE: choose to freeze all inputs or only one input when you use the freeze function.
PIP BACKGROUND COLOR: here you chose the automatic color of PIP background, black is the default color. 
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7.2.6 Output management

A short summary of each output settings 
appears on the main page. You can see the 
number of outputs, their resolution, rate and 
HDCP status. 
Select an output to adjust by either clicking on 
it from the column on the left, or clicking the 
configuration cog icon for that output.

Once the individual output setup page is 
opened, you have access to:  

-  MODE: choose your rate generation mode, 
internal (free-running within the unit) or 
Framelock by choosing an input as a reference 
input,

-  FORMAT: choose the output resolution 
format, 

-  RATE: choose the signal timing standards, if 
the mode is set to internal

-  STATUS: the status menu will show you the current output status,
- APPLY: click on this button to apply the new format/rate,
- PLUG STATUS: indicates the status of the attached monitor and confirms connectivity, 
-  TYPE: you can choose the type of output synchronization on the analog plug, for example RGsB for sync on 

green, or RGBHV for separate H and V sync wires, 
-  FORCE DVI MODE: select this box to force the output to DVI mode instead of the default HDMI autosense 

mode. When in DVI mode, no embedded audio will be transmitted, 
-  PATTERN: a selection of patterns is available to test your output. These patterns will override any input 

selection that you might have. 
You can choose from: 
• No Pattern – turns the pattern off 
• Vertical or horizontal Grey Bars – displays grey bars 
• Vertical or horizontal Color Bars – displays color bars 
• Grid – displays an 8x8 box grid pattern 
• SMPTE bars – displays the SMPTE color bar pattern 
•  Vertical Burst – displays alternating black and white 1 pixel wide columns 
•  Centering – displays a 1 pixel wide dotted line at the edge of the output (only available for computer 

formats)
• Vertical or horizontal gradient – displays a 0 to 100% gradient pattern.

- FLICKER: choose the value of the flicker filter to remove the flicker effect on your interlaced output screen,
- GAMMA: increase or decrease the gamma of your output, 
- HDCP: enable/disable and see the HDCP status.

Depending on the output format chosen, only relevant settings will appear.  

Into the output section, you will be able to manage your output resolutions, formats, sync types, test patterns, 
etc. On the SETUP > OUTPUT TAB, the following screen will appear:

7.2.6 Output management
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7.2.7 Input management

Custom format
The device offers the possibility to create your own output format:

Choose CVT mode (restricted settings) or FULL mode (full settings) and 
start to create your format by adjusting the Horizontal Vertical pixels, 
frame rates  and reduced blanking. 
Click on CHECK to verify if your format is a valid signal. You can SAVE 
and LOAD your Custom format.

Once your outputs are configured, you have now to configure the inputs connected to your device.
Under the inputs section, you can view your inputs by active plugs or by all plugs (active and inactive).

In both cases, an AUTOSET ALL can be launched to set up automatically your inputs. 
Once the AUTOSET ALL is done, you can check one by one your inputs and see if they were correctly detected 
by checking the input STATUS. The input STATUS is defined by a FORMAT and a RATE. If that information is 
not available, your input has not been properly detected or set up.

In this case, you can enter manually into each input settings by using the left menu:

Under the SIGNAL tab, you will find: 
-  ACTIVE PLUG: select the plug used by the unit at the moment. 

Only this plug can be displayed on your output, 
-  SETUP PLUG: select the plug you want to set up, all changes will 

be applied to this plug, even if this plug is active or not (do not 
mismatch with the active plug),

-  SIGNAL TYPE: define the type of your signal, video SD/HD YUV/
RGB or Computer HV/SOG etc., 

- ENABLE: enable/disable the input, 
-  REF SYNC: affect the input to the ref sync input. Use this box 

only if your source is genlocked with the referenced source 
(framelock feature), 

- LABEL: rename your input according to your source,
-  AUDIO MAPPING: select the audio input that will be linked with 

the video input,
-  EMBEDDED SIGNAL AUDIO: status indicates if an embedded 

audio signal is detected or not,

7.2.7 Input management
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7.2.7 Input management

- STATUS: format and size of the input,
- CONTROL:  Black: select Black to transform your input in a uniform color,
  Freeze: use this button to freeze the specific input,
- EDID: choose the EDID for the selected plug.

Under the HDCP section, you can: 
- Enable/disable the HDCP communication feature 
-  Read the HDCP status, If the HDCP status says Active, this output connection is currently utilizing HDCP to 

protect the signal. if the HDCP status indicates Idle, this output connection is currrently not utilizing HDCP. 

Next is the IMAGE tab, where you can find all settings about the display of your input:

Under the COLORIMETRY section, you have: 
- LEVEL: define the selected input luminosity level, 
- CONTRAST: define the selected input contrast level, 
- COLOR: define the selected input color level (0:black and white, full: full color), 
- HUE: set up the hue phase of your NTSC signal.  

Under the USER GAIN section, you find: 
- THE RED/GREEN/BLUE: increase/decrease the Red/Green/Blue level of your input.

Next you have the ASPECT tab. All settings about the blanking and aspect ratio are available there: 

Under the BLANKING ADJUSTEMENTS: 
- H&V POSITION SIZE: you can manually adjust the input blanking with the V&H size or position.
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Under the ASPECT RATIO section: 

-  ASPECT IN: forces a particular aspect ratio for the source.  (5:4, 4:3, etc). This setting has no effect when set 
to native, 

-  PREDEFINED CROP: choose a specific cropped ratio if you use a source with black bands on top/bottom or 
left/right, 

- ASPECT OUT: define the way the image will be displayed into a layer (full screen, centered, cropped or 1:1), 
- OVERSCAN: choose to apply or not a predefined zoom on the image (use with video signal). 

Next settings available on the ASPECT tab are: 

-  CROP: use the Top, Bottom, Left and Right values to 
crop your input. 

 

The next tab is the USER FORMAT:
In this tab, you can explicitly define the input format. The input 
format is automatically detected by the Eikos² but you can change 
it or force it. The available formats are close to the current one, in 
terms of lines. This is only available for analog computer formats.

Keying Feature
With the keying feature, you will be able to key easily a color space 
or a specific luma on an input. 
The device offers an individual keying for each input. Into the input settings, find the keying menu:
You have 2 ways of using the keying: 

- COLORKILLER: classic color keyer removing a specific color space defined by user, 
- LUMAKILLER: luma keyer removing a specific lumanance level range.

7.2.7 Intput management
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7.2.8 Logo management

Keying setup can be done either by setting directly color references and 
tolerances or by using the color grab assistant.

-  INVERT BUTTON: at any time you can choose to invert the 
actual keying using this button.

DSK TITLING: after your keying, the DSK titling feature allows you to play with the transparency of your 
deleted pixels. Enabling this, simply adjust the opacity settings to make your keyed pixels less or more dark. 
This is useful when keying white or light colored text over a bright background.

How to use the LUMA KEY:
Select the lumakiller and then adjust manually, the luma level: 

- Manually: set the minimum luminance value.
Luma Low Level:  Everything darker than this value will be keyed away.
Luma High Level: Everything brighter than this value will be keyed away. 
Then adjust the maximum luminance value to define the range of luminance levels which will be deleted.  
Once you have completed the setup of your keyed input, place the it in layer B on top of your background 
(such as a camera in layer A) in order to complete the keyed title or lower third effect. 

How to use the CHROMA KEY:

-  Manually: set the Hue and luminance to choose the color space you want to delete into your image. 
Set it manually looking at the color change into Current color. If you want, you can quickly select a color from 
a color panel, clicking on CURRENT COLOR. Then click on the color itself to obtain the color panel. Once 
your main color is chosen, you can define a degree of tolerance around this color. The tolerance will define, 
around the main color, an area that will be keyed too. You may still need to make further adjustments to the 
luminance level to complete your key effect.

-  Grabber: activate the grabber to grab the color you want to key. Move the cursor and click on the grab 
button to grab the color.

To save a logo/frame click on this button:

The next page opens.
From here you can capture from the main or from the Preview.
You can still freeze the output before saving your logo/frame.
You can also utilize the logo keying feature to key away part of the image before saving the logo.  

7.2.8 Logo/frame management
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7.2.9 Video out

Select the area you want to save using the adjustable 
white square.
Once it is ok, simply click on execute to save the logo.

How to save a frame:

Choose first Program or Preview, click on FREEZE if you 
want to freeze your output. Then click on EXECUTE to save 
your frame into the selected slot.

Into this section, choose the output format of the video output.

You will find the status of your output and the possibility to choose the test pattern. In addtition, you can 
adjust:
-  FLICKER: choose the value of the flicker filter to disabled the flicker effect on your screen (interlaced lines 

effect),
- GAMMA: increase or decrease the gamma of your output,
- OVERSCAN: enable/disable the overscan/underscan,
- SHARPNESS: adjust the sharpness of the image.

Clicking on Layout, you have the choice between a 4/3 or a 16/9 
aspect ratio.
You can still play with the H/V position and H/V size in order to adjust 
accurately the video out image on your final screen.

7.2.9 Video out
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7.2.10 Audio management

The audio section permits the management of level, balance, and other audio settings for each input.

7.2.10 Audio management

Before modifying the audio settings, be sure to check the audio 
input mapping. Each video input has one audio source mapped to 
it. The audio mapping configuration is found under Menu > Inputs 
> each input.  

Into the AUDIO SETTINGS:
To display only the Current audio input which is played, click on 
Current button.

If you want to select which audio input will be displayed, click on 
the list button then select the input audio source you want.
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7.2.10 Audio management

To setup your analog audio input, simply click on “ON PRELIST”, if you have a Preview output, 
the audio input will be played on it. Then adjust the GAIN from -11 to +6dB. 

A red indicator light will be displayed if you reach the input clip. If the input clip light is being 
illuminated, it means that the input gain is too high and the signal is being distorted. To solve this 
issue, decrease the gain value. The 0dB corresponds to a +4dBu signal in input. 
The gain manual adjustment is only available for analog input.

For every input, you have the possibility to set up your source as a mono audio or stereo audio 
source. 

You have the possibility to adjust the level vs right level using the Pan knob.

All input still have their own level which is 0 by default, decrease or increase the value to modify 
the sound level:

Specific feature:
- DIGITAL SOURCE: all digital sources will have their sample rate displayed,
- SDI SOURCE: on SDI source you can choose 2 channels on one of the 4 groups.

The available audio output controls depend on the device setup 
configuration. If you are in a program/preview mode, you will have 
program/preview audio outputs. If you are in matrix mode, you will 
have 2 programs audio outputs.

For the audio output, you will find:
- A LEFT/RIGHT PAN ADJUSTMENT 
-  A GAIN ADJUSTMENT: this setting will help you to calibrate the 

analog audio output component. Depending on the device you will 
use after the analog way device, adjust carefully the analog gain. 
Basically, for a 0 level, the default value is 4 dBu.

-  A MASTER LEVEL: it indicates the level of your input. On its right, a  
bar will move up and down to indicate the audio level in real time. A 
red button will turn on if the maximum level is reached.

-  A DELAY ADJUSTMENT: the delay can be automatically calculated 
or manually adjusted. To adjust it manually, first disable the Auto 
button.
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7.2.11 Service management

Into the service section, you will find tools to warn you if the unit has a 
problem.
Under TEMPERATURE, there is the alarm tab. If any fan FPGA or board 
are faulty, it will be displayed.

TECHNICAL SUPPORT: Display the different technical support contacts depending on your area.

In this menu, all specific settings, which cannot be sorted under the other menus, are listed: 

Network 
The interface loaded into the unit uses the IP configuration. 
Under INTERFACE, you can define a new: 
- IP address 
- Netmask 
- Gateway 
- Port: choose the port 
- Protocol: choose TCP (by default) or UDP 

Functions
Under function, you can edit:
- TIME: the internal real time clock,
-  AUTO LOCK: when this feature is enabled, you will 

be locked out from selecting empty inputs that have 
no source connected,

- LCD BRIGHTNESS: adjust the brightness of your LCD,
-  KEY BRIGHTNESS: adjust the brightness of your 

keyboard.

Erase memories 
Into this section, you can erase individual settings. 
•  Erase input settings memory: all input settings will return to their default value. This includes image, aspect, 

user format and keying parameters. 
• Erase thumbnail: all the thumbnails you store on your computer will be erased.

Factory reset 
Click on start to erase all settings (except network and RCS² parameters). The unit will reboot itself after the 
factory reset. 

7.2.11 Service management

7.2.12 Control management
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When you enter into the Edit menu, you 
will encounter by default this window. 
On this example, we have the Screen 1 
Program and the Screen 1 Preview. The 
following example can be applied for any 
other output configurations. 

7.3.1 Layer management

7.3.1 Layer management

7.3 Edit

To display an input into one of the 
available layers A, B or C, simply drag and 
drop the input from the left column to 
the layer on the chosen screen. You can 
assign or change the inputs directly on 
Program as well as Preview.

To display a logo, open the logo list column (next to the source list) and then drag and drop the desired logo 
onto the logo layer.  The same procedure is used to display a Background Frame.

You can assign a source to a layer by dropping the selected source into the layer letter icon, located 
on the left side of the layout window. This is particularly useful when the desired layer is hidden 
or blocked by other layers.

When a layer contains an input and is not empty, the 
RCS² displays the input number or a customizable 
thumbnail icon that represents your input. Please 
note: this thumbnail is not a live image. 
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7.3.2 Layer adjustments

The layer properties are found by opening the tab on the right side of the screen. Click on the double arrow 
button on the right to show or hide the layer adjustment tab.

Selected layer
The selected layer status information will indicate which screen, layer and source assigned to that layer are 
selected. You must select a layer in order to see the layer properties menu for that layer. 

Reset feature
You can reset each category of layer settings quickly (Pos/Size, Transparency, Cropping, Border, Transitions, 
Effects, Timing) or you can choose to reset every settings in one click using the ALL button. You can freeze the 
input assigned to the selected layer using the Freeze button.
The settings reset here only affects the selected layer on the selected preset. For example, you can reset the 
layer settings for layer A on Preview, and Program will be unaffected until you press TAKE.

7.3.2 Layer adjusments

In this example, 3 inputs are affected to 3 layers into the Screen 1 Preview. The TAKE button on the bottom 
right side allows sending your configuration, made on the Preview screen, to the Program screen.
With each press of the TAKE button, the Preview screen is transitioned to the Program screen. By default, 
PRESET TOGGLE mode is disabled. That means, after a TAKE, the Preview stays as it was before. The Program 
and Preview will have the same content. 

if desired, you can activate the PRESET 
TOGGLE mode from the SETUP > 
PRECONFIG >MISC menu, which will 
automatically swaps preview and program 
with each TAKE. After each TAKE, the 
Preview is reloaded with the previous 
Program.

Layers management 
In this Edit mode, you have access to a lot 
of preset tools that can help you to create 
the preset you imagined.
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7.3.3 Effects

Position/Size
Adjust the size horizontally (X) or vertically (Y), then adjust the width and the height of your layer. You can 
use the cursor or directly enter a value. To keep the aspect ratio by using the cursor, please enable the KEEP 
ASPECT RATIO button. You will find it on the right of the width and height cursors.

Transparency
Use the Transparency to give at your layer a transparent effect. Layers behind the transparency layer will 
show through more or less based on the transparency value.  

Cropping (only for live layers)
The Cropping feature allows you to cut the part of the image you don’t want. Simply adjust the size horizontally 
or vertically and then adjust the position to display only the desired content. This crop is a layer property, all 
inputs displayed in this layer will be cropped. Do not confuse this setting with 
the input crop which is specific to an input.

Borders (only for live layers) 
Choose a border for this layer from the available patterns including EDGE and 
SHADOW. For each pattern you will have specific values to adjust like colors, 
transparency, width/height or position V and position H.

Transitions
On the Transitions section, you can filter which transitions you want to see. For Example, you can show just 
the Slide, Wipe, Circle or Stretch transitions.
Each layer has an opening and a closing transition. The opening effect will be applied when the layer switch 
from a source to another source or when the layer is switching from empty and appears with a source.
To set up the duration of the transition, please see below the timing and duration settings. If you want to 
force the layer to perform a closing and opening transition, see FORCE TRANSITION.

7.3.3 Effects

Force transition 
The Force Transition button disables the cross-transition between two sources into the 
same layers. Enabling the Force Transition, it forces the layer to go out and then go in with 
the desired effect instead of mixing directly the two sources.

Smooth Move
Enable the Smooth Move to perform a smooth transition on the layer. Disable the smooth move if you require 
a constant speed move.

H&V Flip (only for live layers)
The H&V Flip rotates the PIP on a horizontal or vertical axe. All image data will be flipped. 

7.3.4 Background frame

The Background frame layer acts like any other layer. Simply select it and drag and drop a saved frame. 
The frame 1 is now assigned to the 
Background frame into the Preview 
preset.
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7.3.4 Background frame

Layer layout 

The layer layout gives you access to several predefined layouts with 4, 3, 2 or 1 PIP already sized and placed 
into the output. It can help you to quickly set up 3 PIPs side by side for example. (Number of layers depends 
on the used mode.)

Once clicking on the layout button, you have access to the presets with (4 
when in Quadravision mode) 3, 2, 1 PIPs or all layouts.
Two other options are available below: 
-  Clear other layers: layers already displayed and not included into the 

chosen layout will be cleared 
-  Fade out other layers: layers already displayed and not included into 

the chosen layout will be faded out during the transition. They are still 
present on the preset but with a 100% transparency. 

After selecting the layout, the changes are applied on the selected screen. The size and position of all layers 
are updated. After applying a layout template, you can make further modifications to the layers before Taking 
your selections to Program.

Layer position

A layer position shortcut is also available. After having selected a layer, simply click on the 
Pos. button to have quickly access to a layer position. Choose the new position. The change 
is applied straight away on your preset.

Layer size
You can choose between several aspect ratio. Once selected, the new aspect ratio is applied 
on the selected layer.

Other layer adjustments: 

- CLEAR BUTTON: this button allows you to clear the selected layer from your preset, 

- CLEAR ALL BUTTON: remove all layers from your preset, 

- CONTENT SIZE: set layer size to its content size, 

- SCREEN SIZE: set layer size to screen size, 

- LAYER SIZE/SOURCE RATIO: set the layer size to fit the source ratio,

-  ALIGN BUTTON: you need first to select at less 2 layers, then you can align them horizontally or 
vertically (use Shift to select 2 layers),
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- KEEP ASPECT RATIO BUTTON: enabling this feature will keep the layer aspect ratio during resizing,

- WIREFRAME MODE: allows to enable/disable the layer thumbnails on your RCS², 

-  SHOW LAYER OUT OF SCREEN: enable/disable the possibility to display a layer out of the screen 
into the RCS²,

- TRAP LAYERS ON SCREEN: disable the ability to position the layer off of the screen, 

- HIDE UNUSED LAYERS: empty layers will not be displayed in the RCS², 

- TOGGLE PRESET: enable/disable the TOGGLE PRESET (the Preview becomes the previous Program),

- MOSAIC PREVIEW: enable/disable the Mosaic Preview mode on the PREVIEW monitor (if available),

- RELOAD PROGRAM: load the preset of the Program screen into the Preview screen, 

- STEP BACK: return to the configuration you had before the last TAKE,

-  MIRROR BUTTON: the mirror button allows you to define for each layer the way it will be 
copied in the preset. You can choose to mirror the layer, flip the position, or flip the position and the data 
from another screen. To access this feature, you first need to be in the Matrix mode.

7.3.5 Preset load and save management

Save a preset
Once your preset is set up, you can store it into one of the 64 
preset slots. To do that, click on SAVE MM and choose the number 
corresponding to the slot number.

WARNING: in the RCS², you cannot save a preset for only 1 screen when 
you are in matrix mode, only MASTER MEMORIES can be saved into the 
EDIT section. 
In addition, in the EDIT section, as you work on screen by screen, the load 
button loads only single memory. You will find the load MASTER MEMORIES 
in LIVE MODE. 

The first 8 presets are stored into the unit, all the other presets are stored locally on your computer, and will 
only be available when using the RCS2 software.

If you want to have more details, you can SHIFT+CLICK on any preset to bring up a detailed status window.  In 
this window, you can rename each preset using the PRESET LABEL.

- The first icon displays a window with all preset detail, 
- The second one allows you to let the windows open, 
- The last one quits the window.

7.3.5 Preset load and save management
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7.3.5 Preset load and save management

Load a preset
To recall a previously saved preset, click the Load button (on the right 
side of each screen) and select a preset to load.

Reset button
You can reset a screen using the reset button. Using that, all sizes and positions will be deleted. Your 
layers will be reset. If the «HIDE UNUSED LAYERS» button is enabled and all of your layers are empty 
and hidden, you can still access the layers using the layer icons on the left side of each screen. 
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7.4 Live

The Live mode is designed for easy live operation of the device after you have created some presets.  

On the right, you will find all your saved presets under the tab called “MASTER MEMORIES”. 
A simple drag and drop on the screen will load your preset into the screen (Program or 
Preview).
If you want to change an input into your preset into the live mode, simply use the left source ribbon and drag 
and drop your input into a layer.

You can still use the load master memory to load a master memory from the memory of the device or the 
RCS² using the following windows.

Please click on SAVE MASTER MEMORIES and then choose a number to save the current preset of the unit 
into a master memory.

You can load at any moment a frame or a logo in the same way into a frame or logo layer.
To activate the QUICK FRAME, simply press the Quick Frame button (located on the right side of each screen).

Remember that a preset saved into a screen with a 1024x768 resolution, will keep its size into a screen of 
higher resolution. Therefore, it is best to save preset memories only after you have configured the output 
resolution. 

You still have access to the LOAD/SAVE/RESET preset feature.
Once your preset is ready to send, use the T-bar, or the TAKE button. 
You still have access to STEP BACK button.

7.4 Live
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 When you use several screens, you have the possibility to load a preset on one or several screens. To TAKE 
only one screen separately, select which screens should be affected by the TAKE using this button:   

SEQUENCE: 
The sequence feature consists on a timeline composed by 16 scenes. Each scene can be filled by a preset 
memory. Simply click on MM to choose the memory slot you want to put into the scene. 
To select the memory, simply choose it into the list or drag and drop it into the scene box from the memories 
selection (on the right).

This toolbar acts like a command for your timeline. 
Simply click on play to launch the timeline. 
You can stop the timeline at any moment using the pause or stop button. 
Use the loop button to load again your timeline when it’s finished. 
Take a look at the global time of your timeline thanks to the clock on the right of the toolbar.

Note: To control the Eikos², Analog Way also provides Crestron and AMX modules. For more details, see 
appendices. 

7.4 Live
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8.1.1 Menu navigation

8. OPERATING THROUGH THE FRONT PANEL
8.1 Front panel

To access the Eikos² menu, press the EXIT/MENU button in the control 
section. To highlight items in the menu which will appear on the VFD 
screen, turn the scroll knob left or right to the desired menu item. When 
you have reached the desired menu item, press the ENTER button in the 
control section to access that menu function. Pressing the ENTER button 
when a selection has been made sets the value to that selection in the 
Eikos² memory. When all settings have been made, press the EXIT/
MENU button to exit sub-menus and return to the main menu.

Pressing the MENU button in the menu section of the Eikos², will display and give you access to the following 
items on the menu VFD screen:
-  MODE: select to choose which mode the Eikos² will work in (Mixer/Matrix/Quadravision mode),
-  OUTPUT 1: select to set the output types and resolutions of Output #1,
-  OUTPUT 2: select to set the output types and resolutions of Output #2,
- VIDEO OUT: select to configure Video output card settings,
-  INPUT: select to configure the 10 individual input types and resolutions,
- PRESET: select to store and use presets,
-  PRESET LAYOUT: select a layout for the Quadravision mode,
- IMAGE*: select to change source image settings of an input,
-  KEYING/TITLING*: select to access keying and titling controls and parameters when video layer is selected,
-  SCREEN: setup your background color and your Quick Frame,
-  LAYER*: select to adjust layer size, position, border, transparency or transitions,
-  FRAMES/LOGOS: select to store (record), use and manage logos and frames into the Eikos²,
- AUDIO: select to access all audio input and output parameters,
- OSD SETTINGS: select to display OSD,
-  CONTROL: select to access device software information, LAN settings, reset factory settings, and other user 

oriented functions.

* These items are only displayed if a valid input is assigned to the current layer.

The Eikos² offers 3 modes to work from: the Mixer mode, the Matrix mode which turns your Eikos² into a 
true 10 x 2 scaled matrix with numerous effects and PIPs and logos, and Quadravision mode which displays 
4 live layers.

To choose which mode the Eikos² will operate in, press the EXIT/MENU button and select mode in the menu 
by rotating the scroll knob. Then press the ENTER button to enter the MODE sub-menu. Select the desired 
mode by rotating the scroll knob, and press the ENTER button to confirm your choice. Press the EXIT/MENU 
button to return to the main menu.

8.1.1 Menu navigation

8.1.2 Home menu

8.1.3 Operating modes

Simply selecting a menu item will not set it to that value. Be sure to press the ENTER button when 
parametering the menu items or to push the scroll knob.
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It is strongly recommended resetting all of the default values of your Eikos² unit before setting up your shows 
and events. This will help eliminate confusion caused by unneeded settings from a previous operator. To do 
so, press the EXIT/MENU button and select Control in the menu by rotating the corresponding knob. Then 
press the ENTER button to enter the Reset/Erase sub-menu. Select Default Values by rotating the scroll knob, 
and press the ENTER button to enter your choice to restart your Eikos² with its factory settings. This operation 
should take approximately 30 seconds.

Analog Way engineers have developed a handy, user friendly way of identifying machine status on the front 
panel, via the use of color codes on the buttons of the machine. All new Analog Way machines use the same 
codes, for quick recognition of the status of any device of the range, at any given time.

For the Eikos², button color codes are as follow:
• Sources on the Program output are indicated in red when active,
• Sources on the Preview output are indicated in green when active,
•  Buttons in the layer section turn red or green, depending on whether the selected layer is active in 

respectively the Program or Preview window,
• menu buttons are indicated in green,
•  Selecting a button with an available source or function will cause that button to blink green on the preview, 

or red once it is on the Program output,
• TAKE button reacts as follows: 

- If take function is available, the button will appear in green. 
- When the take function is active, it will light up red.

8.1.4 Reseting default values

8.1.5 Eikos² color codes

8.1.4 Reseting default values

Solid red:
#1 = Source is on the Program output
#2 = Mosaic Preview enable
#3 = Freeze enable

Solid green:

Blinking red:

Blinking green: 

#1 = Source is on Preview
#2 =  Function available for modification
#3 = Current output on Matrix mode

Layer/source selected or is currently active 
on the Program output

Layer/source selected or is not currently 
active on the Program output

8.2 Settings in Mixer mode

Plug your sources using the 4 multi-plug inputs, 2 HDMI Inputs or 4 3G/HD/SD-SDI inputs.
Be sure that all connectors are firmly attached using all available locking screws.

8.2.2 Input selection settings

To set up your inputs automatically: Input menu > Auto settings
You can also do it manually on each input# using the ENTER and the Knob button and set up the inputs type 
one by one.

You can also check your actual input configuration using the config status: Input menu > Config Status

8.2.1 Source Input selection
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8.2.2 Input selection settings

You can find several settings for each input (some settings are specific to some signal type):
- INPUT STATUS: display the input status,
- AUTOSET: launch an automatic setup on the inputs,
- FREEZE: freeze the input,
- ACTIVE PLUG: choose the active plug of the input,
- TYPE: to set up your input type (Computer, Video etc..),
- AUTOSET: launch an autoset on this plug,
- ENABLE: enable/disable the input#,
- SYNCHRONIZED: enable this option when you source is from the same refresh rate than the reference rate,
- HDCP ENABLE: enable/disable the HDCP automatic detection,
- HSYNC LOAD: to change the load of the sync signal,
- 3D COMBO FILTER: choose manually the combo filter for interlaced source,
- FORMAT: for analog source, choose to force a analog format,
- AUDIO INPUT: select the input audio source according to the input video source,
- EDID: set up your EDID for the selected plug,
- STATUS: to summarize the input status.

Concerning the HDMI inputs, a specific feature allows enable/disable the HDCP receiver for the input chosen. 
It can be very useful especially using a Mac: Input menu > HDMI # > HDCP detection

NOTE:  The input status is available at any time in the status input menu and can give you information about 
format rate and HDCP status.

8.2.3 Source Output selection

Once your inputs all have been configured, the output settings of the Eikos² must be set according to the 
machines plugged on your Eikos² Program and Preview outputs (video projector, Preview monitor...).

NOTE:  If you want to use HDCP content from your sources, be sure to attach HDCP compliant screens or 
projectors. If HDCP sources are used with non-HDCP compliant screens, the output image could be 
disabled.

8.2.4 Output selection settings

To set up the output, go in the Program Output or Preview Output menu and choose first the adapted format/
resolution, and then the appropriate rate for your screens by using the knob button and the ENTER button.
Program Output > Output Format > Output rate
Please note that a pair format/rate is only applied when the rate is validated.

Use the native resolution of your screens/projectors in order to obtain the best image quality. In the Preview 
Output menu, you can also match the output configuration the Program Output to the Preview Output by 
checking the case Sync w/Out 1. It allows you to set up your outputs via the output 1 menu.
Preview output > Synch w/Out 1

Some other settings are available too:
- OUTPUT STATUS: display the status of the selected output,
- OUTPUT FORMAT: choose the output format,
- OUTPUT RATE: choose the output rate,
- GAMMA: use this feature to set up the output gamma,
- ANALOG TYPE: set up the type of synchronization of your analog output,
- DVI TYPE: set up the type of color space of your digital output,
- DVI as HDMI: DVI output content as HDMI. Audio is included,
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8.2.4 Output selection settings

- HDCP DETECT: enable or not the HDCP detection on the output,
- CENTERING PIC: display the centering test pattern,
- TEST PATTERN: choose to display one of the available test pattern. 

All changes have to be validated by pressing the ENTER button in order to be saved

NOTE:  The output status can provide you all information about the output in real time. This feature is 
particularly needed when HDCP is used with long cable to be sure that the communication is well 
handled.

Video Out
The Video Out allows you the same settings as other outputs with some additional specific options:
- SHARPNESS: set up the sharpness on the video out image,
- FLICKER FILTER: apply a flicker filter on your video output to eliminate flickering,
- UNDER/OVERSCAN: enable or not the automatic video zoom overscan,
- ADJUST: adjust your video output in term of H/V position and size.
In Matrix mode, the menu “Connection Mode” appears. It allows you to choose recording Output #1 or 
Output #2.

8.2.5 Preview features

The Preview output can display all adjustments before the TAKE.
All current layers for the Program are defined by a colorful frame on Preview. They are identified by a letter 
and a number with the same color.
- Frame: Frx, with x of 1 to 8,
- Layer A: Axx, with xx of 1 to 10,
- Layer B: Bxx, with xx of 1 to 10,
- Layer C: Cxx, with xx of 1 to 10,
- Logo 1: L1x, with x of 1 to 8,
- Logo 2: L2x, with x of 1 to 8,
- Quick Frame.

Because the number of resources available is limited, the Preview displays only one live or still layer at a time. 
The others are only identified by their colorful frame and their number.

8.2.6 Preview mode and OSD settings

The Preview output can display 7 fields on OSD.
To set up your Preview:
menu > OSD Settings > OSD Fields
- Field#1: Input,
- Field#2: Transparency,
- Field#3: Border,
- Field#4: Opening Effect,
- Field#5: Closing Effect,
- Field#6: Smooth Move,
- Field#7: Keying.

8.2.7 Preview Id

The function disables all the display of ID information in Preview mode. The colored frames and numbers 
indicating your source selection on each layer are disabled. To set up your Preview Id:
menu > Control > Functions > Preview Id
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8.2.8 How to use the Mosaic 

8.2.8 How to use the Mosaic Preview 
feature

The Mosaic Preview displays all inputs on 
one screen with live information about the 
input status.

8.2.9 Working with layers

• To assign a source to a layer, press the Layer button, press the Source# you want to assign.
Ex: Layer A > Source #4
The source number 4 will be displayed in the Layer A. 
Press TAKE to view the result on the Program screen

• To delete a layer from the Preview screen:
Press Layers # > Press Black button 
Press TAKE to view the result on the Program screen

• To clear all layers on your Preview screen:
Hold the Black button at least 3 seconds
Press TAKE to view the result on the Program screen

• To freeze a layer: Select a Layer > Press Freeze button

Information Availability

Name of input YES

Displaying (Green: Preview - Red: Main - Grey: No source) YES

Resolution if recognized input YES

Line frequency if recognized input YES

HDCP YES

Keying YES

Enable YES

Freeze YES

2 layers 3 layers 3 layers + Frame
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8.2.10 Working with layers functions

8.2.10 Working with layers functions

Once a source is assigned to a layer, you will have access to some layer settings in the Layer menu or direct-
ly by pressing the layer button.

The settings available depend on the layer selected:
- Layer adjusts: set up layer size and position,
- Layer zoom: set up layer zoom size and position,
- Size Templates: adjust a specific size (Fullscreen, 1/2, 1/3, ...),
- Transparency: adjust the layer transparency,
- Border: choose the border and adjust its properties,
- Opening and Closing effect: adjust the Open/Close effect type and duration,
- Smooth move: enable/disable smooth move,
- H&V Flip: flip the data of the layer,
- Status: get the selected layer status.

All changes have to be validated by pressing the ENTER button in order to be saved

Press TAKE to view the result on the Program screen.

Settings available:

Settings Background live / PIP#1 PIP#2 PIP#3

Position YES YES YES

Size YES YES YES

Zoom YES YES YES

Transparency YES YES YES

Border YES YES YES

Opening effects YES YES YES

Closing effects YES YES YES

Smooth Move YES YES YES

H Flip / V Flip YES YES YES

Even the logo and frame buttons can access to their own settings, but a logo/frame# has to be affected too.

The Program output can displayed simultaneously up to 7 layers stacked from bottom to top as follows:

- Frame: one stored frame selected from 8 available,
- Layer A: one source selected from 10 inputs available,
- Layer B: one source selected from 10 inputs available,
- Layer C: one source selected from 10 inputs available,
- Logo 1: one stored logo selected from 8 available,
- Logo 2: one stored logo selected from 8 available,
- Quick Frame: one of the 8 frames available.

8.2.11 Opening transitions and closing live layers

When transitioning live layers, depending on how many scalers are in use, the Eikos² TAKE function will act 
in one of 3 different ways when transitioning the next preset (Preview) to the current preset (Program):

• TAKE 1 - shot: Case #1
- There are enough scalers for making a transition
- All inputs are locked on to scalers
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8.2.12 Layer adjustment menu

- There are no contraints for closing before the TAKE
- All opening and closing transitions can be performed simultaneously.

• TAKE 2 - shot: Case #2
- There are enough scalers for making a transition
- All inputs are locked on to scalers before the TAKE
- There are no constraints for closing during the TAKE
-  All the necessary closing transitions are performed to free occupied scalers and then the Eikos² performs 

all openings (for example, when a frame or a logo needs to be changed, except with Cut effect).

• TAKE sequenced - shot: Case #3
- There are not enough scalers for making a transition
- All inputs are not locked on to scalers
-  All the necessary closing transitions are performed to free occupied scalers. The Eikos² locks on to new 

sources and performs all openings.

8.2.12 Layer adjustment menu

• To have access to the layer adjustment menu, a source has to be affected to your layer:
Press Layer# button > Press source #

• Once a source is attached to layer, you can have access to the layer adjustment menu:
Press Layer# button
Press TAKE to view the result on the Program screen

• To adjust layers, there is a shortcut on a front panel too:
Press Layer# button > Press ADJ button

8.2.13 Layers with transitions & borders

Transitions
All the settings are available in the Layer menu after pressing the selected layer.
The transition effects have some shortcuts on the front panel too.  
To use it: Press the selected Layer # > Press the Cut, Fade, User #1, #3 or User #2, #4 button

The effect will be immediately attached to the selected layer (Preview).
Concerning the User 1, 3 and User 2, 4 button, they have to be set up before in the Control menu > Func-
tions > Front panel > Prog. Keys

- CUT: duration time can be set to delay the cut effect,

- FADE:
• Adjustable pre-timed fades or manual transition with T-Bar,
• Fade between any input, computer or video,
• Adjustable cross-fading duration,

A

B
B

A

B
AProgram

Preview

Program

Preview
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8.2.13 Layers with transitions & borders

- WIPE:
•  Numerous wipes can be selected horizontal and vertical, from the center or outside, in circle, Zoom in and 

out,
• Horizontal: from left, center -or- vertical: from up, down, center,

- SLIDE:
• Sliding of video or computer images during the transition,
• Horizontal: from/to left, right -or- vertical: from/to up, down.

The Eikos² offers 33 seamless transition effects including 31 options, in addition to a dissolve (fade) and a 
cut effect.

A

WIPE DOWN HARD WIPE UP HARD

WIPE RIGHT HARD WIPE LEFT HARD WIPE CENTER OUT HARDWIPE CENTER IN HARD WIPE CURTAIN IN 
HARD

WIPE ANGLE TOP LEFT 
CORNER HARD

WIPE ANGLE BOTTOM 
LEFT CORNER HARD

WIPE ANGLE TOP RIGHT 
CORNER HARD

WIPE ANGLE BOTTOM 
RIGHT CORNER HARD

WIPE CIRCLE BOTTOM 
LEFT CORNER HARD

WIPE CIRCLE BOTTOM 
RIGHT CORNER HARD

WIPE CIRCLE TOP LEFT 
CORNER HARD

WIPE CIRCLE TOP 
RIGHT CORNER HARD

WIPE CIRCLE CENTER 
OUT HARD

STRETCH DOWN
HARD

STRETCH UP
HARD

STRETCH RIGHT HARD

FADE

STRETCH LEFT HARD

CUT SLIDE DOWN HARD SLIDE UP HARD SLIDE RIGHT HARD SLIDE LEFT HARD

SLIDE ANGLE TOP 
LEFT CORNER HARD

SLIDE ANGLE BOTTOM 
LEFT CORNER HARD

SLIDE ANGLE TOP 
RIGHT CORNER HARD

SLIDE ANGLE BOTTOM 
RIGHT CORNER HARD
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8.2.14 Capturing frames

- BORDER:
The border has to be setting up in the Layer Menu:
Press Layer# button > go in border menu > select and set your border with color and size
Press TAKE to view the result on the Program screen.

NO BORDER

SHADOW BORDER (4 possible orientations)

•  A transparency can be applied 
to the shadow border

•  Size and style of layer border are 
adjustable

EDGE BORDER

8.2.14 Capturing frames

It is possible to store up to 8 frames in the Eikos² non volatile memory. To capture a frame, display the exact 
content you want to save on one of your outputs, at the exact resolution, you can use the freeze button if you 
want. Then follow this step:
Logos/Frames menu > record Frame menu > Frame #

Choose the frame number slot and wait until the unit finishes to save. Your frame is now saved and you can 
use it through the frame button.

STRETCH CURTAIN
IN HARD

STRETCH CENTER
OUT HARD

STRETCH CENTER
IN HARD
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8.2.15 Working with frames

The capture of frames can be done only under the following conditions:
- The capture can be done from the Program output or the Preview output,
- The disappearance of frames or logos on the Preview and Program output is normal during saving.

A frame captures the state of the specified output at the output resolution, and must be recalled using the 
same output resolution. Resizing or other image manipulation of the captured frame is not possible.
Attempting to use a frame at a different resolution will result in a partial frame display or a frame which does 
not fill the screen.
During the capture, the output is outlined by a white border and includes the pixels into the white rectangle.

8.2.15 Working with frames

Frames are mainly used as backgrounds in a typical show or event setup, and can be recorded from any of 
the Eikos² 10 sources and called back at the press of a single button. To use a frame, be sure first that it is well 
saved, then:
Press Frame button > Press Frame # button

NOTE:  Frames may be used only one at a time and can be placed only in the frame layer.

8.2.16 Opening transitions & closing still layers (logos or frames)

When transitioning still layers, depending on how many scalers are in use, the Eikos² TAKE function will act in 
one of 2 different ways when transitioning the next preset (Preview) to the current preset (Program):

- TAKE shot: 1 
• All still frames make an opening and closing phase.
•  All sources of the same layer are completely different between the current preset and the next preset. The 

opening and closing effects of the layer are set to Cut.

- TAKE shot: 2
• One of the layer makes a change of source which is not in Cut.
• The opening and closing phases can be done with different effects.
•  The still frame appears and disappears of the layer with the following effects: Cut, Fade, Slide or Wipe.

8.2.17 Frame input setup menu

In the frame input setup menu, you have the possibility to save a frame, and the possibility to erase a stored 
frame:
Logos/Frames menu > save Frame > Frame #
Logos/Frames menu > Erase > Frame #

8.2.18 Frames as layer

The frame is considered as a layer and has some settings available: Pos./Size, Transparency, Opening/Closing 
effect, Smooth move and Status.

Those settings have to be used as layer settings. Press frame button to have access to the layer menu settings.

You can change frame or delete frame on the Preview screen using the same way the layers do: 
- Delete: Press frame button > Press Black
- Change: Press frame button > Press another Frame #
Press TAKE to view the result on the Program screen.
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8.2.19 Layer transitions & effects

8.2.19 Layer transitions & effects

The Eikos² offers a wide variety of transitions between the scenes you create for your shows and events. It 
allows for live recall of 8 user presets, each of which you can edit at any given time.

1.  Whether catering for complex event  setups, or putting together intricate shows, your Eikos² will also deli-
ver some of what you could expect from a dedicated mixer, along with its switcher and scaler capabilities.

2.  In the Layer Selection section, press the Layer A button. The button will start blinking. On your Preview 
screen, Layer A will appear as a color rectangle. The parameters of the layer will automatically appear on 
your Eikos² VFD menu screen.

3.  In the Layer Menu, make the position, size, border and transparency settings you like, then select Opening 
Effect in the layer options, press the ENTER button and select Type. Select Slide Left - Right for example, 
and press the ENTER button to confirm. Navigate to Duration in the Opening Effect sub-menu, and set the 
duration of your effect by rotating the SCROLL knob and pressing ENTER.

Repeat the procedure in the Closing Effect sub-menu to determine the way your layer will close. Try Slide 
From Left - Right for the closing type with a duration of 1.5 seconds for example.

8.2.20 Capturing logos

To capture a logo, display the exact content you want to save on the Program or Preview screen, you can use 
the freeze button if you want. Then follow these steps:
Logos/Frames menu > Record Logo menu > Set up your logo > Store menu > logo# 

To set up your logo you have several features available:
- Position / Size Adjustment
- Keying type
- Luma / Chroma key
- Cut out color.

Select the logo number you want to save and wait until the unit finishes saving. Your logo is now saved and 
you can use it through the logo button.

You can save up to 8 logos with the Eikos².

The capture of logos can be done only with the following conditions:
- The capture can be done on the Program output or the Preview output
- The disappearance of logos on the Preview and Program output is normal during saving.

The logos are captured with the same size as is visible on the Program output without any form of adjust-
ments. If zooming is required, resize the layer or use the layer zoom or input zoom. 

A logo captures the state of the defined area on the specified output at the Program output resolution, and 
must be recalled using the same output resolution. Resizing or other image manipulation of the captured 
logo is not possible.

The capture zone is outlined by a white rectangle and includes the pixels beneath the white border. The non-
captured area has a reduced brightness.
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8.2.21 Capturing an animated logo

Logo capture is limited in the number of pixels being captured. When the logo capture area is resized, exten-
ding the horizontal size may reduce the vertical size to compensate.

Logos can also be captured and displayed with transparent areas. By adjusting the keyer in the logo capture 
menu, the portions of the captured area can be keyed away and captured as transparent.

The logo “Cut out color” can help display which portions of the image will be captured as tranparent.

NOTES: 
•  The cut out color is only a visual tool to help identify the transparent areas of the logo. These colored re-

gions will not be captured but later displayed as transparent area.
•  Capturing a “logo” is limited to a small percentage of the output resolution. To capture and display a full 

screen image, use the still “frame”.

8.2.21 Capturing an animated logo

To capture animated logo, display the exact content you want to save on the Program screen, you can use the 
freeze button. Then follow this step:
Logos/Frames menu > Record Anim menu > Set up your Anim > Store menu > logo# 

To set up your animation, you have several features available:
- Position / Size Adjustment
- Keying type
- Luma / Chroma key
- Recording time
- Cut out color
Select the animated logo #8 and wait until the unit finishes saving. Your animation is now saved and you can 
use it through the background logo button.

Only one animated logo can be saved in the Eikos². 

8.2.22 Logos input setup menu

In the logos/frames menu, the logos can be deleted in the Erase menu:
Logos/Frames menu > Erase menu > Select Logo#

8.2.23 Working with logos

A simple or animated logo can be manipulated through the front panel. On the front panel, the logo# are 
associated to the input# respectively. To assign a logo# to the logo layer:
Press Logo1 Layer button > Press Input#

Logos #1 to #8 are available directly by the input # button on the front panel. 

You can change logos or delete logos on the Preview screen using the same way the layers do:
- Clear: Press Logo (#1 or #2) button > Press Black
- Change: Press Logo (#1 or #2) button > Press another Input#

8.2.24 Logos as layer

Logos are under the layer rules, you will have direct access to settings by pressing the logo layer button. You 
have 2 logos layers buttons available.
You can use the Pos/Size/Zoom adjustment button and the Effect button from the front panel too.
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8.2.25 Creating presets

8.2.25 Creating presets

The Eikos² allows the creation of user defined presets very easily. Any setup you have configured on screen, 
can be stored into one of the 8 available user presets.

1.  After having configured layers, transitions, logos... on your screen, go to the Preset menu by pressing the 
EXIT/MENU button, and select Preset by rotating the scroll knob. Then, press the ENTER button to enter 
the Preset sub-menu. Choose Preset Copy by scrolling with the corresponding knob, and press the ENTER 
button to access the sub-menu.

2.  In the sub-menu, choose Save From Program or Save From Preview to determine which screen you want 
to memorize the preset from, then set the preset memory (#1 to #8) you wish to use as your “User Preset” 
(by default, the Eikos² will choose the next available preset in the Eikos² memory). 

By pressing the ENTER button, the Eikos² will ask you to confirm. Select Yes, your screen is memorized as a 
preset.

8.2.26 Working with presets

The 8 user presets of the Eikos² can be recalled at any stage during your show or event.
1.  Press the PRESET button, then press one of the eight first preset buttons to choose which memory (#1 to 

#8) you wish to use. The preset will be displayed on your Preview screen.
2.  Once you have selected your preset, simply press the TAKE button to view the result on your main screen. 

8.2.27 Working with audio

Into the audio menu, you will find some audio adjustments:

• Audio mode: 
- NO AUDIO: the audio of your device is switched off
- PRESET MODE: the standard mode of use of the device

You have two possibilities:
▪  Top layer: the sound on the output will follow the audio input of the top layer.
▪  Breakaway: when breakaway is activated, the audio on the output is memorized into the preset. A change 

of preset, changes the audio on the output. A change of content into a video layer has no effect on the 
audio.

-  ROUTING MODE: in this configuration, simply choose an audio input to assign it to the output. The audio 
configuration remains the same during the show.

• Source settings: into this menu you will have access to all source settings:
- ANALOG SETTINGS: 

▪ Mute: select to mute the input
▪ Stereo: select to choose between mono or stereo input
▪ Analog gain: set up the analog gain of your analog input (0 for 4dBu)
▪ Level/balance: select to adjust the input audio level and right and left balance.

- DIGITAL AUDIO: 
▪ SPDIF/AES3: choose the digital audio output mode

• Main audio/prelist audio: define the main or prelist audio settings:
- PRESET MODE: 

▪ Top layer: the sound on the output will follow the audio input of the top layer.
▪  Breakaway: when breakaway is activated, the audio on the output is memorized into the preset. A change 

of preset, changes the audio on the output. A change of content into a video layer has no effect on the 
audio.
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8.2.28 Special features

▪  Master mute: select to mute your master audio
▪  Stereo: select to choose between mono or stereo output
▪  Analog level: set up the analog gain of your analog output (4dBu by default)
▪  Master volume: set your master volume of the output
▪  Balance: set the right/left balance of your output.

8.2.28 Special features

- DYNAMIC FIT (automatically activates the transparent background)

• Automatic adjustment of the layer (Ratio) to fit the source image borders during a transition.

• Dynamic & Automatic adjustment of the layer to fit the source image borders (Black Stripe).

Layer

Frame

Image live
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8.2.28 Special features

- SMOOTH MOVE EFFECT
•  Smooth Move layer control the acceleration of the layer. The time 

can be different between the opening and closing layer,

- WORKING WITH DSK (Chroma / Luma key)
•  Eikos² allows to use a live source with green or blue (or any color) 

background and to key it over another live input,
• Background is removed and replaced by another source,
• Title can be keyed (DSK) on Analog or Digital Sources.
To use keying, first select a source in the desired layer:
Layer button > source number button

Then in the main menu, select the Keying/Titling menu.

You now have several choices to key your sources. The Luma Key and the Chroma Key based on the Luma 
pixel values and the Chroma pixel values and for both an additional Titling menu which can be useful to 
choose the transparency value of your keying.

Keying/Titling menu > Type menu > Select your keying type

Once your keying mode is selected, the Eikos² provides you some keying advance setting:

For Luma Key: 

•  Luma Keying is used to key from a particular luminous intensity. It produces a hard edged key based on 
intensity, which is most suitable for titling effects. You can choose to key things that are extremely dark or 
extremely bright and keep everything in between, or invert to key only things that are of a medium intensity. 

•  The black and white levels define where to begin the keying. In the range 0 to 255, 0 represents no luminance, 
or black and 255 represents full luminance, or white.  
-  Level Black: As the Black Level is changed from 0 to 255, things that are black are first keyed out, followed 

by dark grey, then light grey, and so forth, until the entire picture is keyed out at 255.
-  Level White: As the White Level is changed from 255 to 0, things that are white are first keyed out, 

followed by light grey, then dark grey, and so forth, until the entire picture is keyed out at 0.

+ =>

White levelBlack level

Keyed Away Keyed AwayVisible Picture

Non-Inverted mode
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8.2.28 Special features

For Chroma Key:

Chroma Keying is used to key from a particular color. It produces a key which is most suitable for moving 
images and “weatherman” style applications.  

- Color grabber:
Select Chroma Key menu > Select Color grabber menu

Using a crosshair, you can select a particular hue based on what is on screen.  Once you have adjusted the 
crosshairs to a desired position, press set/enter to capture the color value at that instant.  You can then adjust 
the other parameters such as Tolerance to further refine your key.

- Manual Setting:
Select Chroma Key menu > Manual Settings menu

•  R,G,B: these controls allow you to manually select a hue, defined by its Red, Green, and Blue values as you 
can find in Windows (Paint software).

•  Tolerance: the Tolerance parameter allows you to expand your key color selection to include colors which 
are similar to the selected value. A tolerance of 1 will select only the desired hue, whereas a tolerance of 
255 will select nearly all hues.

•  Black Level: this option permits adjustment of the luminance levels of the keyed hue. The Black Level is the 
luminance lower bound. Colors in the selected hue range with a luminance brighter than the Black Level but 
darker than the White Level will be considered part of the key.

•  White Level: this option permits adjustment of the luminance levels of the keyed hue. The White Level is 
the luminance lower bound. Colors in the selected hue range with a luminance brighter than the Black Level 
but darker than the White Level will be considered part of the key.

•  Titling alpha: if you have selected one of the two Titling mode, the titling menu appears. This option places 
a transparent black backdrop behind the entire layer to which the key is applied.  This effect is useful for 
using bright titles on bright backgrounds, such as clouds. 

•  Invert keying: by default, this mode is disabled. When this mode is activated, the key selection will remain 
on screen, and all other portions of the image will be keyed away. For example, you would see the green 
screen behind the actor, while the actor would be keyed away.
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8.3.1 Source Input selection

8.3 Settings in native Matrix mode

8.3.1 Source Input selection

Same as Mixer mode

8.3.2 Input selection settings

Same as Mixer mode

8.3.3 Working with layers

Same as Mixer mode

Settings Layer A Layer B

Position YES YES

Size YES YES

Zoom YES YES

Transparency YES YES

Border YES YES

Opening effects YES YES

Closing effects YES YES

Smooth Move YES YES

H Flip / V Flip YES YES

The layers are used in the same way as the Mixer mode. A source has to be selected to activate the PIP set-
tings. Each layer has its own settings, Layer A on Output #1 is not linked to Layer A on Output #2 in terms of 
settings.

All layers settings are available in the Layer menu once the layer is selected.

NOTE:  Take a look at the blinking of the Matrix mode button to always know on which output you are working 
on.

8.3.4 Source Output selection

Same as Mixer mode.

NOTE:  If you want to use HDCP content from your sources, be sure to plug HDCP compliant screens or 
projectors. If it’s not the case, the output image could be disabled.

8.3.5 Output selection settings

To set up the outputs, go in the Output #1 or Output #2 menu and choose first the appropriate format/reso-
lution and then the adapted rate for your screens by using the knob button and the ENTER button.
Output# > Output Format > Output rate

You can also in the Output #2 menu, synchronise all the changes from the Output #1 to the Output #2 by 
checking the case Synch w/Out 1. It allows you to set up both outputs at the same time.
Output #2 > Synch w/Out 1

Try to use the native resolution of your screens/projectors in order to obtain the best image quality.
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8.3.6 Working with native Matrix mode

NOTE:  The output status can provide you all information about the output in real time. This feature is parti-
cularly needed when HDCP is used thanks to the HDCP status.

All changes have to be validated by pressing the Ok button in order to be saved

Video Out

In native Matrix mode, the menu “connection mode” allows you to choose recording Output #1 or Output #2.
In Matrix mode, the SDI output embeds audio from Output #1 and Output #2.

8.3.6 Working with native Matrix mode

To activate the native Matrix mode:
Mode Menu > Matrix mode Menu

You’ll find all menus from the Mixer mode in the main menu except some specific matrix function added.
To work with native Matrix mode, you have to use the Matrix # buttons first.
For instance, if you want to put the fame #1 on the Output #1 and the live source #3 on the output #2:

Press Matrix #1 button > Press Frame button > Press input #1
Press Matrix #2 button > Press Layer A button > Press input #3
Press TAKE to view the result on both screens 

Don’t forget to press the correct Matrix # button before pressing the Layer selection button, in order to be 
sure doing the manipulation on the correct output.

8.3.7 Working with Cut, Fade or Transitions

All the transitions (Cut, Fade or Transitions) are available in the native Matrix mode. Although the Matrix 
mode is activated, you will be able to perform powerful transition effects seamlessly. It can depend on your 
configuration.

Display mode Presentation Availability

Output #1

Output #1 & #2 side by side

YES

Matrix mode only

Matrix mode only

Matrix mode only

OUT #1

OUT #1

OUT #1

Output #2

Output #1 & #2 Top and Bottom

OUT #2

OUT #2

OUT #2

Menu > Video Out > Connection > Output #1

Menu > Video Out > Connection > Output Titled 
Horizontally

Menu > Video Out > Connection > Output Titled 
Vertically

Menu > Video Out > Connection > Output #2
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8.3.8 Working with presets in Matrix mode

The Eikos² has 4 scalers, to understand how your effect will be performed, you need to know how many 
scalers are used on your outputs. Don’t forget that you always need one free scaler to perform seamless 
transitions. 
Example:
1 layer on each output > 2 scalers used > 2 seamless transitions
2 layers on each output > 4 scalers used > no seamless transition (ie: fade through black)

The frame and the logos are not considered as live layers and are not counted as using a scaler.

8.3.8 Working with presets in Matrix mode

In Matrix mode, you will find a new menu into Preset menu called “Preset management”. This will help you 
to define what kind of preset you want to save:
- BOTH OUTPUT: preset saved for both outputs,
- CURRENT OUTPUT: preset saved only for the current output,
- OUTPUT 1: preset saved only for output #1,
- OUTPUT 2: preset saved only for output #2.

8.3.9 Working with Mirror modes

The Mirror Matrix mode is a specific Matrix mode where the output #2 will be the perfect mirror copy of the 
output #1. In that way, each settings apply to output #1 will be performed on the output #2 too.
Mode Menu > Matrix mode Menu
Using the Matrix mode, several configurations are available, the simple mode and the mirror mode.

1. No Copy: this mode is the standard Matrix mode, output #1 and #2 are independent.

2. Clone mode:  Outputs #1 and #2 will be the same. All changes on output #1 will be affected to output #2. 
Layers will have the same position and size.

OUTPUT #1 OUTPUT #2

OUTPUT #1 OUTPUT #1OUTPUT #2 OUTPUT #2

Using the Mirror mode: to use the mirror mode, simply select the Matrix mode throught the main menu, 
then the mirror mode can be activated layer by layer thanks to the layers menu. Select the chosen layer and 
go in the layer menu, then select the “Layer Copy Mode” menu. There are several mirror positioning options:
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8.3.9 Working with Mirror modes

3. Copy & H.pos Flip mode:  Output #2 will be exactly the same as output #1 except the fact that the selected 
layer will have its H position flipped (standard Mirror mode).

4. Copy & H.Flip all modes:  Output #2 will be exactly the same as the output #1 except the fact that the se-
lected layer will have its H position and data flipped (only for live layers).

OUTPUT #1 OUTPUT #1OUTPUT #2 OUTPUT #2

OUTPUT #1OUTPUT #1 OUTPUT #2OUTPUT #2

NOTES: 
•  Remember to simplify the use of this feature, you need to manipulate Output #1. While in mirror mode, 

Output #2 will follow.
•   Every change on Output #2 will have an effect only on Output #2, but remember that if a change occurs on 

Output #1 after that, Output #2 will update automatically to match output 1.
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8.3.10 Working with frames/logos

8.3.10 Working with frames/logos

The frame/logo can be memorized from Output #1 or #2. To record a frame/logo, please refer to the chapter: 
8.2.14 Capturing frames and 8.2.20 Capturing logos in the Mixer mode.
To use a frame/logo, refer to “Working with frame/logo”.
As a source, each frame/logo can be used by both outputs, you just have to select the correct matrix# button 
first.

Quadravision mode allows the display of up to 4 live sources on a screen. The Preview will display just the 
outline of each layer to show the position, size, and the source attached.
Choose Quadravision mode in the Mode menu, then choose your first template.

To use windows, first attach your source to the desired window, you have to use the windows button in the 
Quadravision field.
Press W# button > Press input #
Press TAKE to apply the change on the main screen.

All windows have the same settings as layers in other modes. You can have access to them by the Layer menu 
or directly by pressing the W# button once a source is attached. You always have access to the shortcut tran-
sition button/black button:
Press W# button > Press the Cut/fade/user1/user2/user3/user4 button to set up the transition

8.4 Settings in Quadravision mode

8.4.1 Working with templates

Some templates are available for the Quadravision mode, you will find them here:
Home menu > Quadravision layout
Templates are just here to provide some useful layer positions, you can adjust them manually at any time. 

W 1
W 1 W 2

W 4

W 4

W 3

W 1 W 1W 2

W 2

W 2W 4

W 4

W 4

W 3

W 3

W 3

W 1

W 3

W 2

W 1

W 1
W 1 W 2

W 4

W 4

W 3

W 1 W 1W 2

W 2

W 2W 4

W 4

W 4

W 3

W 3

W 3

W 1

W 3

W 2

W 1

Win1 Full screen Win2 Full screen

Win3 Full screen Win4 Full screen
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8.4.1 Working with templates

W 1

W 1W 1
W 2W 1

W 3 W 2 W 3

W 2

W 1

W 2

W 1

W 1W 1
W 2W 1

W 3 W 2 W 3

W 2

W 1

W 2

Split 3V Split 3H

Split 2H Split 2V

W 1
W 1 W 2

W 4

W 4

W 3

W 1 W 1W 2

W 2

W 2W 4

W 4

W 4

W 3

W 3

W 3

W 1

W 3

W 2

W 1

W 1
W 1 W 2

W 4

W 4

W 3

W 1 W 1W 2

W 2

W 2W 4

W 4

W 4

W 3

W 3

W 3

W 1

W 3

W 2

W 1

Split Screen

3 x Left + 1 x Right  1 x Top + 3 x Bottom

1 x Left + 3 x Right
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8.4.2 Working with presets

8.4.2 Working with presets

Presets are useful to recall all layers/windows settings pressing just one button. In presets, you’ll save posi-
tion, size, transparency, source attached, etc. (Layers settings). 
The source settings such as colors, zoom, etc., are not saved into a preset. 
You can recall a preset at any time. It will be displayed on your Preview in order to check the content before 
taking it on the main screen.

8.4.3 Creating a preset

Presets are the copy of a configuration. To save it:
Go in the Preset menu > save preset > select the origin and the destination, press Enter to confirm

To load it:
Go in the Preset menu > load preset > select the destination, press Enter to confirm

You can also load a preset directly through the front panel using the presets button:
Press P#1 to #4 or Press shift then P#5 to #8 to load the preset directly to the Preview screen

In the Preset menu, you have access to the step back feature which allows recalling the last configuration on 
the Preview screen.

8.4.4 Working with frames/logos

Logos are available for display in Quadravision mode.
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8.5 Menu tree

8.5 Menu tree

MIXER MODE MATRIX MODE QUADRAVISION MODE

OUTPUT #1

OUTPUT #2

OUTPUT #1

OUTPUT #2

OUTPUT #1

OUTPUT #2

FORMAT:1920X1080
RATE: 50.00HZ

LOCK: INTERNAL

FORMAT:1920X1080
RATE: 50.00HZ

LOCK: INTERNAL

FORMAT:1920X1080
RATE: 50.00HZ

LOCK: INTERNAL

FORMAT:1920X1080
RATE: 50.00HZ

LOCK: INTERNAL

FORMAT:1920X1080
RATE: 50.00HZ

LOCK: INTERNAL

FORMAT:1920X1080
RATE: 50.00HZ

LOCK: INTERNAL

            | PROG.|PRVW.
---------+---------+----------
Logo2 |Logo#1|Logo#8
Logo1 |Logo#1|Logo#7
LayerC|SDI 1 |SDI 4
LayerB|DVI 1 |DVI 2
LayerA|Input1|Input8
Frame |Frame1|Frame8

            |SCR#1   |SCR#2
---------+----------+---------
Logo   |Logo#1 |Logo#8
LayerB|Input1  |SDI 4
LayerA|Input1  |SDI 4
Frame |Frame1|Frame8

            |PROG.|PRVW.
---------+--------+-------
Win.4 |Input1|SDI 4
Win.3 |SDI 2   |SDI 4
Win.2 |DVI 1  |DVI 2
Win.1 |Input1|Input8
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8.5 Menu tree

MODE

OUTPUT1 / OUTPUT2

MIXER MODE

SYNC W/OUT1(O1)

OUTPUT STATUS

OUTPUT FORMAT(O2)

MATRIX MODE

QUADRAVISION MODE

WIN 1 FULLSCREEN

HDTV 720P

SPLIT SCREEN

640X480 4/3

WIN 3 FULLSCREEN

HTDV 1080I

3X LEFT + 1X RIGHT

848X480 16/9

SPLIT 2 H

1152X864 4/3

SPLIT 3 H

1280X768 15/9

1280X1024 5/4

WIN 2 FULLSCREEN

HTDV 1035I

1X LEFT + 3X RIGHT

800X600 4/3

WIN 4 FULLSCREEN

HTDV 1080P

1X TOP + 1X BOTTOM

1024X768 4/3

SPLIT 2 V

1280X720 16/9

1280X960 4/3

SPLIT 3 V

1280X800 16/10

[...]

(O1) Only for OUTPUT 2
(O2)  For OUTPUT 2, only displayed when OUTPUT2 

is not synchronized with OUTPUT1
(O3) Depending on the output format
(O4) Only for interlaced output format
(O5) Only Computer and HDTV
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8.5 Menu tree

23.97HZ(O3)

29.97HZ(O3)

24HZ(O3)

30HZ(O3)

25HZ(O3)

50HZ(O3)

59.94HZ(O3)

1360X768 16/9

1400X1050 5/3

1366X768 16/9

1600X900 16/9

FORMAT CUSTOM 3

1680X1050 16/10

FORMAT CUSTOM 5

1920X1200 16/10

FORMAT CUSTOM 7

FORMAT CUSTOM 1

FORMAT CUSTOM 10

INTERNAL REF

1360X1024 4/3

1440X900 16/10

FORMAT CUSTOM 2

1366X800 15/9

1600X1200 4/3

FORMAT CUSTOM 4

1920X1080 16/9

FORMAT CUSTOM 6

2048X1152 16/9

FORMAT CUSTOM 9

2048X1080

FORMAT CUSTOM 8

[...]

OUTPUT RATE(O2)
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8.5 Menu tree

60HZ(O3)

INPUT 1

INPUT 4

SDI 3

72HZ(O3)

INPUT 2

SDI 1

HDMI 1

SDI 4

75HZ(O3)

INPUT 3

SDI 2

HDMI 2

VIDEO OUT

FOLLOW X0.5

FOLLOW X1

RGBS

AUTO

RGB HV

RGB LIMITED (16-235)

FOLLOW X2

RGsB (SOG)

RGB FULL (0-255)

YUV

YUV

[...]

GAMMA

FLICKER FILTER(O4)

ANALOG TYPE

DVI TYPE

DVI AS HDMI

HDCP DETECTION
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8.5 Menu tree

VIDEO OUT

OFF

H COLOR BAR

H GREY SCALE

SMPTE

V-GRADIENT

V GREY SCALE

GRID

V COLOR BAR

BURST(O5)

H-GRADIENT

[...]

TEST PATTERN

CENTERING PIC

CONNECTION(V1)

OUTPUT STATUS

OUTPUT FORMAT

OUTPUT RATE

SCREEN 1

SDTV PAL

23.97HZ(V2)

HDTV 720P

SCREEN H-TILED

EDTV 480P

HDTV 1080I

HDTV 1080P

SCREEN 2

SDTV NTSC

HDTV 1035I

SCREEN V-TILED

EDTV 576P

HDTV 1080P

DCDM 2K

(V1) Displayed in matrix mode
(V2) Depending on the output format
(V3) Only for interlaced output format
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8.5 Menu tree

[...]

ADJUST

GAMMA

SHARPNESS

CENTERING PIC

FLICKER FILTER(V3)

UNDER/OVERSCAN

TEST PATTERN

25HZ(V2)

48HZ(V2)

H POS

30HZ(V2)

59.94HZ(V2)

H SIZE

29.97HZ(V2)

50HZ(V2)

V POS

47.95HZ(V2)

60HZ(V2)

V SIZE

OFF

H COLOR BAR

H GREY SCALE

SMPTE

V-GRADIENT

V GREY SCALE

GRID

V COLOR BAR

H-GRADIENT

24HZ(V2)
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8.5 Menu tree

INPUTS

[...]

SYNC. STATUS

AUTOSET ALL

CONFIG STATUS

INPUT 1

HDMI 1

INPUT 3

SDI 1

SDI 3

INPUT 2

HDMI 2

INPUT 4

SDI 2

SDI 4

INPUT 1: NO

INPUT STATUS

AUTOSET

FREEZE

ACTIVE PLUG

HDMI 1: NO

INPUT 3: NO

SDI 1: NO

SDI 3: NO

INPUT 2: NO

HDMI 2: NO

INPUT 4: NO

SDI 2: NO

SDI 4: NO

INPUT 1
ACTIVE PLUG: (I1)

FRMT: 
RATE: (I2)

SYNC.POL.:(I2)(I3)

HDCP(I2)(I4)

ANALOG

(I1) Displayed when input is a multiplug input.
(I2) Displayed when a valid input signal is detected
(I3)  Displayed when it is an analog plug and when 

the signal is computer HV type
(I4) Displayed for HDMI and DVI-D plugs
(I5)  Displayed when the plug is analog, DVI-D or 

HDMI
(I6) Displayed when the plug is analog
(I7)  Displayed when the plug is analog and the 

signal type is VIDEO RGBS
(I8) Displayed when the plug is not SDI
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8.5 Menu tree

[...]

ANALOG SETTINGS

DVI-D SETTINGS

SDI SETTINGS

HDMI SETTINGS

DVI-D

SDI

HDMI

TYPE(I5)

AUTOSET

SYNCHRONIZED

HDCP ENABLE(I4)

ENABLE

VCR MODE

H. SYNC. LOAD(I7)

3D COMBO FILTER

FORMAT

AUDIO INPUT

SDTV COMPOSITE(I6)

HI-Z

DISABLE

NONE

LOW FILTERING

ANALOG 1

COMPUTER C TTL(I6)

VIDEO YUV(I6)

RGB FULL (0-255)(I6)

SDTV YC(I6)

75 OHMS

DEFAULT

EMBEDDED

HIGH FILTERING

COMPUTER C ANA(I6)

COMPUTER SOG(I6)

RGB LTD (16-235)(I6)

VIDEO RGBS(I6)

AUTO(I6)

COMPUTER BW(I6)

VIDEO RGsB(I6)

YUV(I6)

COMPUTER HV(I6)

AUTO

SDI GROUP

PAL

NTSC

SECAM

GROUP A

GROUP B
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8.5 Menu tree

[...]

EDID current
preferred timing
1920x1080 50Hz

=> Change

LEFT CHANNEL

NONE

640X350 85HZ

640X400 85HZ

720X400 85HZ

640X480 59,94HZ

640X480 72HZ

640X480 75HZ

640X480 85HZ

720X480 59,94HZ

720X576 50HZ

800X600 50HZ

800X600 56HZ

800X600 60HZ

800X600 72HZ

800X600 75HZ

800X600 85HZ

800X600 120HZ RB

848X480 50HZ

848X480 60HZ

1024X768 50HZ

1024X768 60HZ

1024X768 70HZ

1024X768 75HZ

1024X768 85HZ

1024X768 120HZ RB

1152X864 50HZ

1152X864 60HZ

1152X864 75HZ

1280X720 23,976HZ

1280X720 24HZ

1280X720 25HZ

1280X720 29,97HZ

1280X720 30HZ

1280X720 50HZ

1280X720 59,94HZ

1280X720 60HZ

1280X768 50HZ

RIGHT CHANNEL

GROUP C

CHANNEL 1

CHANNEL 3

GROUP D

CHANNEL 2

CHANNEL 4

EDID(I8)

ANALOG 2

ANALOG 4

S/PDIF 2

ANALOG 3

S/PDIF 1
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8.5 Menu tree

[...]

1280X768 60HZ RB

1280X768 60HZ

1280X768 75HZ

1280X768 85HZ

1280X768 120HZ RB

1280X800 50HZ

1280X800 60HZ RB

1280X800 60HZ

1280X800 75HZ

1280X800 85HZ

1280X800 120HZ RB

1280X960 50HZ

1280X960 60HZ

1280X960 85HZ

1280X960 120HZ RB

1280X1024 50HZ

1280X1024 60HZ

1280X1024 75HZ

1280X1024 85HZ

1280X1024 120HZ RB

1360X768 50HZ

1360X768 60HZ

1360X768 120HZ RB

1360X1024 50HZ

1360X1024 60HZ

1366X768 50HZ

1366X768 60HZ RB

1366X768 60HZ

1400X1050 50HZ

1400X1050 60HZ RB

1400X1050 60HZ

1400X1050 75HZ

1400X1050 85HZ

1400X1050 120HZ RB

1440X900 50HZ

1440X900 60HZ RB

1440X900 60HZ

1440X900 75HZ

1440X900 85HZ

1440X900 120HZ RB

1600X900 50HZ

1600X900 60HZ RB

1600X1200 60HZ

1600X1200 60HZ

1600X1200 65HZ

1600X1200 70HZ

1600X1200 75HZ

1600X1200 85HZ
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PRESET

[...]

1600X1200 120HZ RB

1680X1050 50HZ

1680X1050 60HZ RB

1680X1050 60HZ

1680X1050 75HZ

1680X1050 85HZ

1680X1050 120HZ RB

1920X1080 23,976HZ

1920X1080 24HZ

1920X1080 25HZ

1920X1080 29,97HZ

1920X1080 30HZ

1920X1080 50HZ

1920X1080 59,94HZ

1920X1080 60HZ

1920X1200 50HZ

1920X1200 60HZ RB

2048X1080 23,976HZ

2048X1080 24HZ

2048X1080 25HZ

2048X1080 29,97HZ

2048X1080 30HZ

2048X1080 50HZ

2048X1080 59,94HZ

2048X1080 60HZ

2048X1152 50HZ

2048X1152 60HZ RB

STATUS

PRESET MGMT(P1)

PRESET LAYOUTS

BOTH OUTPUTS

DEFAULT

OUTPUT 1

V SPLIT SCREEN(P2)

BKGND + BL PIP(P2)

CURRENT OUTPUT

H SPLIT SCREEN(P2)

BKGND + TR PIP(P2)

OUTPUT 2

BKGND + TL PIP(P2)

(P1) Matrix mode only 
(P2) Displayed depending on the switcher mode
(P3) Only displayed with a valid preset
(P4) Only displayed if there is no valid preset
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8.5 Menu tree

[...]

SAVE PRESET FROM
CURRENT->MEM1

->NO          YES

LOAD PRESET FROM
[SCR1][MEM1]

  -> [SCR1][MAIN]       
->NO          YES

STEP BACK

SAVE PRESET

LOAD PRESET

ERASE PRESET

SAVE FROM
->[ MAIN ]<-

SAVE TO
[ MEM1 ]

LOAD FROM
>[SCR1]<     [MEM1]

LOAD TO
  [SCR1]      [MAIN]

BKGND + BR PIP(P2)

2 PIP V SPLIT(P2)

1T + 2V SPLIT(P2)

3 DIAG PIP(P2)

2 PIP H SPLIT(P2)

1R + 2H SPLIT(P2)

3H PIP(P2)

PRESET MEMORY 1(P3)

PRESET MEMORY 2(P3)

PRESET MEMORY 3(P3)

PRESET MEMORY 4(P3)

PRESET MEMORY 5(P3)

PRESET MEMORY 6(P3)

PRESET MEMORY 7(P3)

PRESET MEMORY 8(P3)

EMPTY(P4)

1L + 2H SPLIT(P2)

1B + 2V SPLIT(P2)
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QUAD. LAYOUTS(Q5)

[...]

WIN 1 FULLSCREEN

WIN 3 FULLSCREEN

1X TOP + 3X BOTTOM

1X LEFT + 3X RIGHT

WIN 2 FULLSCREEN

SPLIT SCREEN

SPLIT 2V

WIN 4 FULLSCREEN

SPLIT 2H

3X LEFT + 1X RIGHT

SPLIT 3H

SPLIT 3V

(Q5) Only displayed in quadravision mode
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IMAGE(G1)

[...]

AUTO CENTERING(G2)

BLANKING ADJUST(G3)

CROPPING

PREDEFINED CROP

ASPECT IN

OPTIMIZE(G2)

UNDER/OVER(G5)

V POS

LEFT

LETTERBX 1.78:1

5/4 (1.25:1)

15/9 (1.66:1)

H TOTAL(G4)

OVERSCAN

V SIZE

RIGHT

LETTERBX 2.35:1

16/10 (1.60:1)

21/9 (2.33:1)

H POS

TOP

NONE

NATIVE

PHASE

UNDERSCAN

H SIZE

BOTTOM

LETTERBX 1.85:1

4/3 (1.33:1)

16/9 (1.77:1)

PILLARBX 1.33:1

(G1)  Displayed when a valid input is affected to a 
layer

(G2)  Displayed for computer analog signal, EDTV 
and HDTV analog video

(G3) Displayed for analog signal
(G4) Displayed for computer analog signal
(G5) Displayed for video signal
(G6) Displayed for interlaced signal
(G7)  Displayed for 50 hz interlaced signal and non-

activated low latency
(G8)  Displayed for 60 hz interlaced signal and non-

activated low latency
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8.5 Menu tree

[...]

ASPECT OUT

COLORIMETRY

LOW LATENCY(G6)

3:2 PULLDOWN(G8)

2:2 PULLDOWN(G7)

RESET SETTINGS

COMPONENT LEVEL(G3)

SHARPNESS

1:1

BRIGHTNESS

RED

LOW

RESET THE PLUG
TO ITS DEFAULT

VALUES?
->NO          YES

FULL SCREEN

COLOR

BLUE

HIGH

CENTERED

CONTRAST

GREEN

MEDIUM

CROPPED

HUE
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8.5 Menu tree

CHROMAKEY(K4)

TITLING ALPHA(K4)

INVERT KEYING(K5)

COLOR GRABBER

TRANSPARENCY

MANUAL SETTING

H POS

R KEY

TOLER.

B KEY

V POS

G KEY

L BLACK

TOLER.

L WHITE

L BLACK

L WHITE

KEYING/TITLING(A4)

[...]

TYPE

LUMAKEY(K2)

NONE

LEVEL BLACK

CHROMAKEY

CHROMAKEY+TITLING

LUMAKEY

LEVEL WHITE

LUMAKEY+TITLING

(K1)  Displayed when a valid input is affected to a layer
(K2)  Only displayed for Type = Luma key or Lumakey 

+Titling
(K3)  Only displayed for Type = chroma key or chromakey 

+Titling
(K4)  Only displayed for Type = Lumakey +Titling or 

Chromakey +Titling
(K5) Only displayed for Type different than none
(A4)  Displayed if the switcher is on mixer or quadravision 

mode
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8.5 Menu tree

SCREEN SETTINGS

[...]

SCREEN 1

SCREEN 2

BACKGROUND COLOR

QUICK FRAME

RED

FRAME 1

FRAME 4

BLUE

FRAME 3

FRAME 6

GREEN

FRAME 2

FRAME 5

FRAME 7

FRAME 8
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8.5 Menu tree

LAYER(Y1)

[...]

LAYER COPY MODE(Y2)

LAYER ADJUST

SIZE TEMPLATES

BORDER(Y3)

TRANSPARENCY

LAYER ZOOM(Y3)

NO COPY

H POS

FULL SCREEN

STYLE

H POS

COPY & H. POS FLIP

HV POS

2/3 FULL SCREEN

H SIZE

1/3 FULL SCREEN

H SIZE

CLONE MODE

V POS

3/4 FULL SCREEN

V POS

COPY & H. FLIP ALL(Y3)

HV SIZE

1/2 FULL SCREEN

V SIZE

1/4 FULL SCREEN

V SIZE

NONE

EDGE

SHADOW

(Y1)  Displayed when a valid input is affected to a 
layer

(Y2) Only displayed in matrix mode 
(Y3) Not available for frame and logos
(Y4) Only slide, wipe and stretch 
(Y5) Only wipe and stretch 
(Y6) Only circle, wipe and stretch
(Y7) Only slide, wipe and circle
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8.5 Menu tree

[...]

OPENING EFFECT

CLOSING EFFECT

TYPE

DIRECTION

EFFECT DURATION

ADJUST

CUT

LEFT TO RIGHT(Y4)

RIGHT TO LEFT(Y4)

BOTTOM TO TOP(Y4)

TOP TO BOTTOM(Y4)

VERTICAL FROM CENTER(Y5)

HORIZONTAL FROM CENTER(Y6)

HV FROM CENTER(Y6)

FROM BOTTOM LEFT CORNER(Y7)

FROM BOTTOM RIGHT CORNER(Y7)

FROM TOP LEFT CORNER(Y7)

FROM TOP RIGHT CORNER(Y7)

FADE

WIPE

CLEAN CUT(Y3)

SLIDE

CIRCLE(Y3)

STRETCH(Y3)

H SIZE

TRANSPARENCY

V SIZE

COLOR

SMOOTH MOVE

H FLIP
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8.5 Menu tree

LOGOS/FRAMES

[...]

V FLIP

STATUS

CAPTURE SOURCE(P1)

RECORD FRAMES

RECORD LOGOS

RECORD ANIM

PROGRAM(P2)

FRAME 1

FRAME 2 [EMPTY](F4)

FRAME 3 

FRAME 4

FRAME 5 [EMPTY](F4)

FRAME 6 [EMPTY](F4)

FRAME 7

FRAME 8

POSITION / SIZE ADJUST

KEYING TYPE

LUMAKEY(F6)

SCREEN 1(P3)

PREVIEW(P2)

SCREEN 2(P3)

H POS

NONE

LEVEL BLACK

H SIZE

CHROMA

V POS

LUMA

V SIZE

(P1) Matrix mode only 
(P2) Displayed depending on the switcher mode
(P3) Only displayed with a valid preset
(F1)  Displayed in Mixer mode without mosaic 

preview and in Matrix mode
(F2) Displayed in Mixer mode without mosaic
(F3) Displayed in Matrix mode
(F4) Display “empty” is the slot is free
(F5) Only displays logo and valid frame list
(F6) Displayed depending on the type of keying
(F7) Only displayed for animated logo
(F8) Not displayed for animated logo
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8.5 Menu tree

[...]

ERASE

CHROMAKEY(F6)

STORE

CUT OUT COLOR(F6)

FRAME 1(F2)

FRAME 3(F2)

FRAME 4(F2)

FRAME 7(F2)

FRAME 8(F2)

LOGO 1(F2)

LOGO 2(F2)

LOGO 8(F2)

RECORDING TIME(F7)

LEVEL WHITE

COLOR GRABBER

LOGO 1(F8)

LOGO 2(F8)

LOGO 3 [EMPTY](F1)(F8)

LOGO 4 [EMPTY](F1)(F8)

LOGO 5 [EMPTY](F1)(F8)

LOGO 6 [EMPTY](F1)(F8)

LOGO 7 [EMPTY](F1)(F8)

LOGO 8

MANUAL SETTING

H POS

V POS

TOLER.

L BLACK

L WHITE

R KEY

G KEY

B KEY

TOLER.

L BLACK

L WHITE
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8.5 Menu tree

AUDIO

[...]

AUDIO MODE

SOURCE SETTINGS(A1)

DIGITAL OUTPUT(A1)

NO AUDIO

PRESET MODE

ROUTING MODE

ANALOG INPUT 1

ANALOG INPUT 2

ANALOG INPUT 3

ANALOG INPUT 4

DVI INPUT 1

DVI INPUT 2

DVI INPUT 3

DVI INPUT 4

HDMI INPUT 3

HDMI INPUT 4

HDMI INPUT 5

HDMI INPUT 6

SDI INPUT 7

SDI INPUT 8

SDI INPUT 9

SDI INPUT 10

S/PDIF 1

S/PDIF 2

S/PDIF

AES3

MUTE

ANALOG GAIN(A6)

STEREO

LEVEL/BALANCE

LEVEL

BALANCE

(A1)  Displayed if the audio mode is  different of “no 
audio”

(A2) Displayed if the audio mode is “routing mode”
(A3) Displayed if the audio mode is “Preset mode”
(A4)  Displayed if the switcher is on mixer or 

quadravision mode
(A5) Displayed if the switcher is on matrix mode
(A6) Displayed if the audio input is analog
(A7) Displayed if the delay mode is manual
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8.5 Menu tree

[...]

OUTPUT 1(A2)

OUPUT 2(A2)

MAIN AUDIO(A3)(A4)

PRELIST AUDIO(A3)(A4)

OUT1 MAIN(A3)(A5)

OUT2 MAIN(A3)(A5)

PRESETMODE (A3)

DELAY MODE

MASTER MUTE

STEREO

ANALOG LEVEL

MASTER VOLUME

BALANCE

SOURCE

BREAKAWAY

TOP LAYER FOLLOW

AUTO ADJUST

MANUAL ADJUST

NONE

INPUT 1

INPUT 2

INPUT 3

INPUT 4

HDMI 1

HDMI 2

SDI 1

SDI 2

SDI 3

SDI 4

LEVEL

BALANCE
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8.5 Menu tree

[...]

OUT1 PRELIST (A3)(A5)

OUT2 PRELIST (A3)(A5)

AUDIO DELAY(A7)

SOURCE

NONE

INPUT 1

INPUT 2

INPUT 3

INPUT 4

HDMI 1

HDMI 2

SDI 1

SDI 2

SDI 3

SDI 4

LEVEL

BALANCE

CONTROL VERSIONS

VERS: 1.0.0
VARIABLE SET : 1

--------------------
CALIMERO

MAIN MICRO :
--------------------

CAMELYA
DESIGN:

SOFTWARE:
IHS:

TSTP:
--------------------

FELINDRA
DESIGN:

SOFTWARE:
IHS:

TSTP:
--------------------

TATIANA
DESIGN:

SOFTWARE:
IHS:

TSTP:
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8.5 Menu tree

CONNECTION

FUNCTIONS

RS232 / LAN

AUTO LOCK

AUTO TAKE 

PRESET TOGGLE

AUTO QUICK FRAME

DYNAMIC FIT

PREVIEW ID

HIDE UNUSED

FREEZE MODE

LAN SETUP

RS232 BAUD RATE

RS232

LAN

TCP

UDP

1200 BAUDS

2400 BAUDS

9600 BAUDS

19200 BAUDS

57600 BAUDS

115200 BAUDS

INPUT FREEZE

FREEZE ALL

DEVICE ADDRESS...

REMOTE ADDRESS...(C1)

GATEWAY ADDRESS...

DEVICE PORT...

REMOTE PORT...(C1)

NETMASK...

DEFAULT SETUP RESET THE LAN
PARAMETERS?
->NO          YES

[...]

(C1) Only displayed in UDP
(C2) Displayed for User1, User2, User3 and User4
(C3) Displayed if the effect type is not cut or fade
(C4)  Displayed if at least one custom format is not valid
(C5) Displayed if the custom format is valid
(C6) Displayed if no custom formats are valid.
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8.5 Menu tree

HDCP SUMMARY

FRONT PANEL

IN1 DVI-D: IDLE

IN2 DVI-D: IDLE

IN3 DVI-D: IDLE

IN3 HDMI: IDLE

IN4 DVI-D: IDLE

IN4 HDMI: IDLE

IN5 HDMI: IDLE

IN6 HDMI: IDLE

OUT1 DVI-D: IDLE

OUT2 DVI-D: IDLE

KEY LOCKING

STANDBY

DATE/TIME

BAUD RATE

SET MESSAGE ON

SET MESSAGE OFF

CLEAR MESSAGE ON

CLEAR MESSAGE OFF

STANDBY

YEAR

MONTH

DAY

HOUR

MINUTE

SECOND

MENUS + KEYBOARD

ONLY MENUS

[...]
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8.5 Menu tree

RESET/ERASE

MATRIX TK MODE

ERASE CUST.FRMT

RESET LAYERS

ERASE MEMORIES

ERASE PRESETS

PROG. KEYS

LCD BRIGHTNESS

KEY BRIGHTNESS

TAKE BOTH

TAKE CUR.SCREEN

ALL(C4)

COMPUT.CUSTOM1(C5)

COMPUT.CUSTOM2(C5)

COMPUT.CUSTOM3(C5)

CUT

FADE

USER 1

USER 2

USER 3

USER 4

RESET THE LAYERS
POSITION AND SIZE?

->NO          YES

ERASE ALL THE
IMAGE SETTINGS?

->NO          YES

ERASE ALL THE
PRESET MEMORIES?

->NO          YES

TYPE(C2)

DIRECTION(C2)(C3)

EFFECT DURATION

ERASE ALL THE
CUSTOM FORMATS?

->NO          YES

[...]
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8.5 Menu tree

TECH. SUPPORT

DEFAULT VALUES

THE AMERICAS
TECHSUPPORT@ANALOGWAYUSA.COM

TEL: +1 212 269 1902
---------------------

EUROPE, MIDDLE EAST AND AFRICA
TECHSUPPORT@ANALOGWAY.COM

TEL: +33 (0)1 81 89 08 76
---------------------
ASIA, PACIFIC

TECHSUPPORT@ANALOGWAYASIA.COM
TEL: +65 6292 5800

COMPUT.CUSTOM4(C5)

COMPUT.CUSTOM5(C5)

COMPUT.CUSTOM6(C5)

COMPUT.CUSTOM7(C5)

COMPUT.CUSTOM8(C5)

COMPUT.CUSTOM9(C5)

COMPUT.CUSTOM10(C5)

EMPTY(C6)

RESET THE DEVICE
TO ITS DEFAULT VALUES?

->NO          YES
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9. 1 Dashboard (RCS²)

9. MAINTENANCE AND SUPPORT

On the RCS², you have access to a chart with general information on the unit.
Please click on the Dashboard button:

On this chart, you will find under the INFO tab, the 
Device name, the Serial number of your product, the 
actual firmware and the software version of the RCS².
Under CONNECTIVITY, you will find the current IP 
address of your unit and its MAC address.

9.1 Dashboard (RCS²)
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10.1 HDCP

10. APPLICATIONS NOTE AND TIPS

HDCP is a content protection mechanism which uses encrpytion to prevent high value content from being 
delivered to non-authorized devices. For example, Blu-ray players use HDCP on their HDMI outputs to ensure 
that the HDMI output cannot be routed to a digital recording device.  

The Eikos² is fully HDCP compliant, meaning that you will be able to use the Eikos² to accept HDCP protected 
sources and route them to any HDCP protected outputs. As Analog Way is a licenced HDCP adoptor, this also 
means that the Eikos² is prevented from displaying any HDCP protected images on any non-HDCP compliant 
outputs (as is the case for all licenced HDCP compliant devices).  

HDCP can only be used on certain connection formats, including DVI, HDMI, and Displayport. Keep in mind 
that simply because a connection is using a DVI, HDMI, or Displayport connection, it does not guarentee 
that the devices connected are maintaining an active HDCP connection. For example, you may find video 
recording or capture devices equipped with an HDMI input, however HDCP licencing forbids these devices 
from capturing HDCP protected content.  

HDCP is not supported on connection formats such as composite, component, Svideo, SD-SDI, HD-SDI, 
3G-SDI, or VGA. This means that any source which becomes protected by HDCP cannot be converted to 
these formats. For example, while you may find a Blu-ray player which can directly output a composite video 
signal, HDCP licencing forbids converting the HDCP protected HDMI signal back to composite or any other 
non-protected format.  

To help troubleshoot HDCP in your installation, each input and output page is equiped with HDCP status 
information to indicate in realtime when HDCP encryption is being used.  

Certain devices such as Macintosh computers can be misleading to use in conjunction with an HDCP 
compliant presentation switcher such as the Eikos². This is because devices like the Mac computers can be 
used to output both HDCP protected content (such as a movie downloaded from iTunes) as well as non-
HDCP protected content (such as a Keynote presentation or the desktop). When a computer first connects 
to an HDCP compliant device such as the Eikos², it learns the capabilities of the device through the EDID 
connection. Upon seeing the HDCP compatibility of the attached Eikos², devices like the Mac computers will 
immediately attempt to use HDCP encrpytion at all times, despite the content currently displayed on the 
computer screen. Since this source would now be considered an HDCP protected source, the Eikos² would 
be required to prevent it from being displayed on VGA or SDI outputs and only allow it to be displayed on 
outputs protected by HDCP. To work around this problem, the Eikos² allows the HDCP features of a particular 
input to be disabled, which in turn informs the Mac computer to avoid using HDCP, and allows content such 
as Keynote and the desktop to be displayed, as this input will no longer use HDCP protection.  Please note 
that disabling the HDCP features of the input do not circumvent HDCP protections, and thus do not allow you 
to view any content which requires this protection.  

For more information about HDCP, please refer to our whitepapers on HDCP, or visit the HDCP foundation 
website.

10.1 HDCP
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11.1 Warranty conditions

11.1 Warranty conditions

11.2 Repair and return instructions

11.3 Return conditions

11. WARRANTY

Analog Way warrants the product against any defects in materials and workmanship for a period of three 
(3) years from the date of purchase when used in accordance with the user’s manual and standard industry 
practices. 
•  In the unlikely event of any malfunction from such defects during the warranty period, Analog Way will, at 

its discretion, repair or replace the defective units.
• The warranty does not apply if the product is determined to have been: 

- Improperly installed or abused, 
- Handled with improper care,
- Used or stocked in abnormal conditions,
- Modified, opened, 
- Damaged by fire, war, or Natural disasters (Acts of God) 

• Analog Way’s direct employees are solely authorized to make this determination.
• Analog Way reserves the right to refuse for repair and service a product for which the warranty is void.
•  In no way shall Analog Way be responsible for direct or indirect loss of profit or consequential damages 

resulting from any defect in this product.  

NOTE:  Analog way offers a warranty extension of 2 years, it includes parts, labor and return shipping. If you 
are interested, please contact your territory sales representative.

These Return Material Authorization (RMA) regulations determine the procedure to be followed when 
returning defective product. The aim is to ensure fast and simple handling of the returned product and bring 
the best satisfaction
In the unlikely event that a product is required to return for repair, please call the regional Maintenance 
center/Customer Service, and ask to receive a Return Material Authorization number (RMA). Three regional 
maintenance centers are available depending on your location. (See chapter: 12. Contact information)
•  Before sending any device to Analog Way, please contact us to obtain a Return Material Authorization 

(RMA) number. Please have the model and serial number available and the reason for calling. 
•  RMAs are valid for 30 days, after which a new RMA must be requested. 
•  Package the unit securely in the original shipping materials or suitable equivalent. Analog Way is not 

responsible for damage which occurs due to improper packaging. The customer assumes responsibility 
until the unit arrives at our facility.

•  Out-of-warranty products will be charged an evaluation fee if no problems are found or if you choose not 
to proceed with the repair. 

• Discontinued products are not admitted for return and repair. 
• Be sure to include the RMA number clearly on the shipping label or on the exterior of the package.
• No unit will be accepted without a valid RMA clearly visible.

In the unlikely event that you want to return the product, please call the regional Maintenance center/
Customer Service
•  If you are unhappy with the performance of any product purchased from us, you can return it within 30 

days of purchase.
• Returned equipment must be in original condition with all accessories and packaging materials.
• Returns may be subject to a refurbishment and/or restocking fee.
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12. Contact information

12. CONTACT INFORMATION

Analog Way SAS - Headquarters
Tel.: +33 (0)1 81 89 08 60
Fax: +33 (0)1 57 19 04 54
2/4 rue Georges Besse 
92160 Antony 
FRANCE

Sales/General information: 
saleseuro@analogway.com

Technical support: 
techsupport@analogway.com
Tel.: +33 (0)1 81 89 08 76

Analog Way Inc.
Tel.: +1 212 269 1902
Fax: +1 212 269 1943
 299 Broadway, Suite 1620 
New York, NY 10007 
USA

Sales/General information:
salesusa@analogway.com

Technical support: 
techsupport@analogwayusa.com

Analog Way Pte Ltd
Tel.: +65 6292 5800
Fax: +65 6292 5205
152 Beach Road 
#15-03 Gateway East 
SINGAPORE 189721
            
Sales/General information: 
sales@analogwayasia.com

Technical support: 
techsupport@analogwayasia.com

Analog Way Germany
Tel.: +49 7161 5075668
salesgermany@analogway.com

Analog Way Italy
Tel.: +39 02 39493943
salesitaly@analogway.com

Analog Way UK
Tel.: +44 (0)2076 979133
salesuk@analogway.com

UNITED STATES

FRANCE

ITALY

SINGAPORE

GERMANY

UNITED KINGDOM

UNITED STATES

FRANCE

ITALY

SINGAPORE

GERMANY

UNITED KINGDOM

UNITED STATES

FRANCE

ITALY

SINGAPORE

GERMANY

UNITED KINGDOM

UNITED STATES

FRANCE

ITALY

SINGAPORE

GERMANY

UNITED KINGDOM

The Americas

Europe, Middle East & Africa

Asia Pacific



104

13.1 Crestron 2 & 3 series

13. APPENDICES
13.1 Crestron 2 & 3 series Midra™ Driver

Using this driver, software developers and integrators can easily provide 
powerful solutions for remotely controlling any Midra™ series Switchers 
through Crestron 2-series or 3-series Control Systems®. 

The package includes:
-  The precompiled driver modules that can be used for recalling presets, selecting source inputs, changing PIP 

content, configuring audio inputs and outputs…,
-  One sample SIMPL program that demonstrates the use of all the features available within this driver 

(3 projects provided, targeting Crestron QM-RMC, MC3 and CP2E Control Systems®),
-  Two VTPro sample projects, one for XPanel and one for the Crestron Mobile Pro® application (for iPad® and 

Android™ devices), both running with the sample program mentioned above,
- Help files in French and English.

The samples provided are ready-to-use programs and can be freely adapted or used as a base to build your 
own real-world Midra™ controller application.

13.2 AMX NetLinx® Integrated Controllers Midra™ Driver

Using this driver, software developers and integrators can easily provide 
powerful solutions for remotely controlling any Midra™ series Switchers 
through AMX NetLinx® integrated controllers. 

The package includes:
-  The precompiled driver modules that can be used for recalling presets, selecting source inputs, changing PIP 

content, configuring audio inputs and outputs…,
-  One sample NetLinx® Studio program that demonstrates the use of all the features available within the 

driver,
-  Two TPDesign4 sample projects, one for AMX Modero® S Touch Panels and one for Apple® iPad, both 

running with the sample program mentioned above,
-  Help files in French and English.

The samples provided are ready-to-use programs and can be freely adapted or used as a base to build your 
own real-world Midra™ controller application.
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